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1. INTRODUCTION

The RCM4510W next-generation RabbitCore modules add ZigBee®/

802.15.4 functionality to the existing Rabbit® 4000 microprocessor
features to allow you to create a low-cost, low-power, embedded wire-
less control and communications solution for your embedded control

system. The Rabbit® 4000 microprocessor features include hardware
DMA, clock speeds of up to 60 MHz, 1/O lines shared with up to six
serial ports and four levels of alternate pin functions that include vari-
able-phase PWM, auxiliary 1/0O, quadrature decoder, and input capture.
Coupled with more than 500 new opcode instructions that help to
reduce code size and improve processing speed, this equates to a core
module that is fast, efficient, and the ideal solution for a wide range of
wireless embedded applications.

The Development Kit has the essentials that you need to design your
own wireless microprocessor-based system, and includes a complete
Dynamic C software development system. This Development Kit also
contains a Prototyping Board that will allow you to evaluate the
RCM4510W modules and to prototype circuits that interface to the
RCM4510W modules. You will also be able to write and test software
for these modules.

In addition to onboard ZigBee/802.15.4 functionality, the RCM4510W model has a Rabbit 4000
microprocessor operating at 29.49 MHz, static RAM, flash memory, two clocks (main oscillator
and timekeeping), and the circuitry necessary for reset and management of battery backup of the
Rabbit 4000’s internal real-time clock and the static RAM. One 50-pin header brings out the Rab-
bit 4000 1/O bus lines, parallel ports, and serial ports. A separate 14-pin auxiliary 1/0O header
brings out up to nine additional 1/0 pins (up to four of which may be configured as analog inputs)
made possible by the onboard XBee RF module.
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The RCM4510W receives its +3.3 V power from the customer-supplied motherboard on which it
is mounted. The RCM4510W can interface with all kinds of CMOS-compatible digital devices
through the motherboard.

1.1 RCM4510W Features

Small size: 1.84" x 2.85" x 0.54"
(47 mm x 72 mm x 14 mm)

Microprocessor: Rabbit 4000 running at 29.49 MHz
Up to 40 general-purpose 1/0 lines configurable with up to four alternate functions

Up to 9 additional general-purpose 1/O lines (up to four of which may be set up as analog
inputs) available through the XBee RF module

3.3V 1/0 lines with low-power modes down to 2 kHz

Six CMOS-compatible serial ports — four ports are configurable as a clocked serial port (SP1),
and two ports are configurable as SDLC/HDLC serial ports.

Alternate 1/0 bus can be configured for 8 data lines and 6 address lines (shared with parallel I/
O lines)

512K flash memory, 512K data SRAM
Real-time clock

Watchdog supervisor

Currently there is one production model with a choice of XBee firmware. Table 1 summarizes its
main features.

Table 1. RCM4510W Features

Feature RCM4510W
Microprocessor Rabbit® 4000 at 29.49 MHz
Flash Memory 512K
Data SRAM 512K

6 shared high-speed, CMOS-compatible ports:
6 are configurable as asynchronous serial ports;
4 are configurable as clocked serial ports (SPI);

Serial Ports 2 are configurable as SDLC/HDLC serial ports;
1 asynchronous serial port is shared with the XBee RF module
1 asynchronous serial port is used during programming
XBee RF Module Digi International® XBee® zB (802.15.4 standard, ISM 2.4 GHz)

ZNet 2.5 RCM4510W (ZNet) (20-101-1207)

XBee Firmware

ZigBee PRO | RCM4510W (ZB) (20-101-1269)
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Section 1.3.2.1 provides additional information about the two types of XBee firmware.

RCM4510W RCM4510W
PREVIEW VERSION STANDARD RELEASE
o | (B o

Figure 1. RCM4510W Versions

There are two versions of the RCM4510W model—the standard release, available after April,
2007, is identical in form and function to the preview version. The difference between them is that
the RF module is made of discrete onboard components in the preview version, and is included in
the pluggable Digi International® XBee® RF module on the standard release. The height of the
preview version is also about 0.01” (0.2 mm) less than that of the standard release; Rabbit rec-
ommends that you use the dimensions for the standard release specified in this manual in your
design. The preview version has not undergone certification testing and is intended for develop-
ment purposes only. The preview version will no longer be offered once the standard release is
available.

NOTE: At the present time the Digi International® XBee® RF modules used with the
RCM4510W are not compatible with other XBee® and XBee PRO® RF modules such as those
used with Rabbit’s ZigBee®/802.15.4 Application Kit

The RCM4510W is programmed over a standard PC USB port through a programming cable sup-
plied with the Development Kit.

NOTE: The RabbitLink cannot be used to program the RCM4510W or other RabbitCore mod-
ules based on the Rabbit 4000 microprocessor.

Appendix A provides detailed specifications for the RCM4510W.
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1.2 Advantages of the RCM4510W

Fast time to market using a fully engineered, “ready-to-run/ready-to-program” microprocessor
core.

Competitive pricing when compared with the alternative of purchasing and assembling indi-
vidual components.

Easy C-language program development and debugging

Rabbit Field Utility to download compiled Dynamic C .bin files, and cloning board options for
rapid production loading of programs.

Generous memory size allows large programs with tens of thousands of lines of code, and sub-
stantial data storage.

Reference application uses a low-cost, low-power ZigBee/802.15.4 infrastructure to connect
Rabbit-based devices

Supports ZigBee/802.15.4 point-to-point, point-to-multipoint, and mesh topologies
Easily scalable for commercial deployment applications

RCMA4510W can function as a network coordinator, router, or end device
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1.3 Development and Evaluation Tools
1.3.1 RCM4510W Development Kit

The RCM4510W Development Kit contains the hardware essentials you will need to use the
RCM4510W module. The items in the Development Kit and their use are as follows.

e RCM4510W module.
= Prototyping Board.

= Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., U.K., and
European style plugs). Development Kits sold in North America may contain an AC adapter
with only a North American style plug.

= USB programming cable with 10-pin header.

= 10-pin header to DB9 serial cable.
= 14-pin IDC socket connector with bare leads ribbon cable.

- Digi® XBee USB (used as ZigBee coordinator).

= Dynamic C® CD-ROM, with complete product documentation on disk.
= Getting Started instructions.

= A bag of accessory parts for use on the Prototyping Board.

= Rabbit 4000 Processor Easy Reference poster.

= Registration card.

= S &

Universal
AC Adapter
with Plugs

Programming
Cable

Accessor) v Parts for
Prototyping Board

Figure 2. RCM4510W Development Kit
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1.3.2 Software

The RCM4510W preview version is programmed using version 10.11 or later of Dynamic C, and

the standard version requires version 10.21 or later. A compatible version is included on the Develop-
ment Kit CD-ROM.

Starting with Dynamic C version 10.40, Dynamic C includes the popular pC/OS-I1 real-time
operating system, point-to-point protocol (PPP), FAT file system, RabbitWeb, and other select
libraries. Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure
Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library.

In addition to the Web-based technical support included at no extra charge, a one-year telephone-
based technical support module is also available for purchase. Visit our Web site at www.rab-
bit.com or contact your Rabbit sales representative or authorized distributor for further informa-
tion.

1.3.2.1 XBee Firmware

There are two types of XBee firmware available for the RCM4510W — ZNet 2.5 and ZigBee
PRO. The firmware preloaded at the factory on your RCM4510W is indicated with the model
number and is reflected in different part numbers (see Table 1). A label on the XBee RF module
identifies the factory-installed firmware type. Older RCM4510W modules shipped with ZNet
firmware and do not have a sticker on their XBee RF module.

@CM451 ow (ZNe@ [RCM4510W (ZB)]

= ZNet 2.5 is a networking solution that was developed around an earlier draft of the ZigBee
standard, and will work only with the MaxStream or Digi International® XBee® RF modules
used with the RCM4510W or with the preview version of the RCM4510W. Applications built
around ZNet 2.5 may be upgraded to the ZB solution by loading the ZB firmware (standard
release RCM4510W RabbitCore modules only) and by recompiling the application using
Dynamic C v. 10.46 or later.

= ZB firmware was developed using the ZigBee PRO feature set and provides the most advanced
ZigBee networking capabilities that will interface with any other devices based on the ZigBee
PRO standard adopted in 2007.

Dynamic C v. 10.46 and later versions support the ZB firmware with a 64-bit extended PAN
ID instead of a 16-bit PAN ID

Rabbit recommends ZB firmware for new customers and new applications.

NOTE: While both ZNet 2.5 and ZB firmware types are technically ZigBee, the protocol layer in
them is different and devices with one type of firmware will not function in a network with
devices using the other firmware.

1.3.3 Optional Add-Ons
Rabbit has a Mesh Network Add-On Kit available for the RCM4510W.
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= Mesh Network Add-On Kit (Part No. 101-1272)

» Digi® XBee USB (used as ZigBee coordinator)
» Two XBee ZB RF modules
» Two RF Interface modules

» Digi® XBee USB and serial cables

The XBee ZB RF module is installed on the RF Interface module, which can be connected via
an RS-232 serial connection to a Windows PC for setup. The Mesh Network Add-On Kit
enables you to add additional devices to explore a ZigBee mesh network.

Contact your authorized Rabbit distributor or your sales representative for more information, or
visit our Web site.

1.3.4 Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the documentation
menu is placed on the workstation’s desktop. Double-click this icon to reach the menu. If the icon
is missing, use your browser to find and load default.htm in the docs folder, found in the
Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download from
our Web sites as well.
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2. GETTING STARTED

This chapter describes the RCM4510W hardware in more detail, and explains
how to set up and use the accompanying Prototyping Board.

NOTE: This chapter (and this manual) assume that you have the RCM4510W Development Kit.
If you purchased an RCM4510W module by itself, you will have to adapt the information in
this chapter and elsewhere to your test and development setup.

2.1 Install Dynamic C

To develop and debug programs for the RCM4510W modules (and for all other Rabbit hardware),
you must install and use Dynamic C.

If you have not yet installed Dynamic C version 10.11 (or a later version), do so now by inserting
the Dynamic C CD from the Development Kit in your PC’s CD-ROM drive. If autorun is
enabled, the CD installation will begin automatically.

If autorun is disabled or the installation does not start, use the Windows Start | Run menu or
Windows Disk Explorer to launch setup.exe from the root folder of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the pro-
cess are self-explanatory.

Dynamic C uses a COM (serial) port to communicate with the target development system. The
installation allows you to choose the COM port that will be used. The default selection is COML.
You may select any available port for Dynamic C’s use. If you are not certain which port is avail-
able, select COML. This selection can be changed later within Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Specifying a
port in use by another device (mouse, modem, etc.) may lead to a message such as "*could
not open serial port" when Dynamic C is started.

Once your installation is complete, you will have up to three new icons on your PC desktop. One
icon is for Dynamic C, another opens the documentation menu, and the third is for the Rabbit Field
Utility, a tool used to download precompiled software to a target system.

If you have purchased any of the optional Dynamic C modules, install them after installing
Dynamic C. The modules may be installed in any order. You must install the modules in the same
directory where Dynamic C was installed.
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2.2 Hardware Connections

There are three steps to connecting the Prototyping Board for use with Dynamic C and the sample
programs:

1. Prepare the Prototyping Board for Development.

2. Attach the RCM4510W module to the Prototyping Board.

3. Connect the programming cable between the RCM4510W and the PC.
4. Connect the power supply to the Prototyping Board.

2.2.1 Step 1 — Prepare the Prototyping Board for Development

Snap in four of the plastic standoffs supplied in the bag of accessory parts from the Development
Kit in the holes at the corners on the bottom side of the Prototyping Board as shown in Figure 3.

NOTE: Pay attention to use the hole that is pointed out towards the bottom left of the Prototyping
Board since the hole below it is used for a standoff when mounting the RCM4510W on the Pro-
totyping Board.

Figure 3. Insert Standoffs
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2.2.2 Step 2 — Attach Module to Prototyping Board

Turn the RCM4510W module so that the mounting holes line up with the corresponding holes on
the Prototyping Board with the programming header at the top right. Insert the metal standoffs as
shown in Figure 4, secure them from the bottom using the 4-40 screws and washers, then insert
the module’s header J1 on the bottom side into socket RCM1 on the Prototyping Board.

Programming
Header

RCM4510W

000

Insert standoffs
between

mounting holes and
Prototyping Board.

Line up mounting
holes with holes
on Prototyping Board. R e

Figure 4. Install the Module on the Prototyping Board

NOTE: Itisimportant that you line up the pins on header J1 of the module exactly with socket
RCM1 on the Prototyping Board. The header pins may become bent or damaged if the pin
alignment is offset, and the module will not work. Permanent electrical damage to the module
may also result if a misaligned module is powered up.

Press the module’s pins gently into the Prototyping Board socket—press down in the area above
the header pins. For additional integrity, you may secure the RCM4510W to the standoffs from
the top using the remaining three 4-40 screws and washers.

NOTE: If you are using the preview version of
the RCM4510W, do not connect the program-
ming cable to header J3 (shown below the
programming header at right). Header J3 is r gL
used only by the factory. B S Programming

Programming

<« Header
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2.2.3 Step 3 — Connect Programming Cable

The programming cable connects the module to the PC running Dynamic C to download pro-
grams and to monitor the module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J2 on the
RCM4510W as shown in Figure 5. Be sure to orient the marked (usually red) edge of the cable
towards pin 1 of the connector. (Do not use the DIAG connector, which is used for a standard
serial connection.)

Figure 5. Connect Programming Cable and Power Supply

NOTE: Never disconnect the programming cable by pulling on the ribbon cable. Carefully pull
on the connector to remove it from the header.

Connect the other end of the programming cable to an available USB port on your PC or worksta-
tion.

Your PC should recognize the new USB hardware, and the LEDs in the shrink-wrapped area of
the USB programming cable will flash — if you get an error message, you will have to install
USB drivers. Drivers for Windows XP are available in the Dynamic C Drivers\Rabbit USB
Programming Cable\WinXP_2K folder — double-click DPInst.exe to install the USB driv-
ers. Drivers for other operating systems are available online at
www.ftdichip.com/Drivers/VVCP.htm.
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2.2.4 Step 4 — Connect Power
Once all the other connections have been made, you can connect power to the Prototyping Board.

First, prepare the AC adapter for the country where it will be used by selecting the appropriate
plug. The RCM4510W Development Kit presently includes Canada/Japan/U.S., Australia/N.Z.,
U.K., and European style plugs. Snap in the top of the plug assembly into the slot at the top of the
AC adapter as shown in Figure 5, then press down on the spring-loaded clip below the plug
assembly to allow the plug assembly to click into place. Release the clip to secure the plug assem-
bly in the AC adapter.

Connect the AC adapter to 3-pin header J1 on the Prototyping Board as shown in Figure 5. The
connector may be attached either way as long as it is not offset to one side—the center pin of J1 is
always connected to the positive terminal, and either edge pin is ground.

Plug in the AC adapter. The PWR LED on the Prototyping Board next to the power connector at
J1 should light up. The RCM4510W and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board next to the battery holder to
allow a hardware reset without disconnecting power.

To power down the Prototyping Board, unplug the power connector from J1. You should discon-
nect power before making any circuit adjustments in the prototyping area, changing any connec-
tions to the board, or removing the RCM4510W from the Prototyping Board.
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2.3 Run a Sample Program

If you already have Dynamic C installed, you are now ready to test your programming connec-
tions by running a sample program. Start Dynamic C by double-clicking on the Dynamic C icon
on your desktop or in your Start menu.

You may have to select the COM port assigned to the USB programming cable on your PC. In
Dynamic C, select Options > Project Options, then select this COM port on the “Communica-
tions” tab. Then check “Use USB to Serial Converter” in “Serial Options.” Click OK to save the
settings.

Find the file PONG. C, which is in the Dynamic C SAMPLES folder. To run the program, open it
with the File menu, then compile and run it by pressing F9. The STDIO window will open on your
PC and will display a small square bouncing around in a box.

2.3.1 Troubleshooting

If you receive the message Could Not Open Serial Port, check that the COM port assigned
to the USB programming cable was identified and set up in Dynamic C as described in the pre-
ceding section.

If you receive the message No Rabbit Processor Detected, the programming cable may be
connected to the wrong COM port, a connection may be faulty, or the target system may not be
powered up. First, check to see that the power LED on the Prototyping Board is lit. If the LED is
lit, check both ends of the programming cable to ensure that it is firmly plugged into the PC and
the programming header on the RCM4510W with the marked (colored) edge of the programming
cable towards pin 1 of the programming header. Ensure that the module is firmly and correctly
installed in its connectors on the Prototyping Board.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communication
error message when you compile and load a sample program, it is possible that your PC cannot
handle the higher program-loading baud rate. Try changing the maximum download rate to a
slower baud rate as follows.

= Locate the Serial Options dialog on the “Communications” tab in the Dynamic C Options >
Project Options menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can begin
debugging, it is possible that your PC cannot handle the default debugging baud rate. Try lower-
ing the debugging baud rate as follows.

= Locate the Serial Options dialog on the “Communications” tab in the Dynamic C Options >
Project Options menu. Choose a lower debug baud rate.

Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. You should receive a Bios com-
piled successfully message once this step is completed successfully.

2.3.2 Run a ZigBee Sample Program

This section explains how to run a sample program in which the RCM4510W is used in its default
setup as a router and the Digi® XBee USB is used as the ZigBee coordinator.
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1. Connect the Digi® XBee USB acting as a ZigBee coordinator to an available USB port on your
PC or workstation. Your PC should recognize the new USB hardware.

2. Find the file AT_INTERACTIVE.C, which is in the Dynamic C SAMPLES\XBee folder. To run
the program, open it with the File menu, then compile and run it by pressing F9. The Dynamic
C STDIO window will open to display a list of AT commands. Type MENU to redisplay the
menu of commands.

Waiting to join network...
done
Cmd - Description

ATCH - Read the current channel. Will be zero if we
are not associated with a network.

ATID - Set or read the current PAN ID. If you set the 1ID you
must write it to non-volatile memory ("WR") and
then reset the network software ("NR").

ATOP - Read the operating PAN ID.

ATMY - Read the current network address. Will be OxFFFE

if we are not associated with a network.

Read the upper four bytes of the radio IEEE address.

Read the lower four bytes of the radio IEEE address.

Set or read the Node Identifier.

Set or read the maximum number of Broadcast Hops.

Set or read the Node Discovery timeout value (in @.1s).

Set or read the list of channels to scan. This

value is a bit-field list.

ATSD - Set or read the channel scan duration value.

ATNJ - Set or read the Node Joining Time value.

ATAI - Read the Association Indicator. A zero value
means we are associated with a network.

ATPL - Set or read the transmission power level.

ATVR - Read the radio software version number.

ATHV - Read the radio hardware version number.

MENU - Display this menu (not an AT command.)

Valid command formats (AT prefix is optional, CC is command):

[AT]CC OxXXXXXX (where XXXXXX is an even number of hexidecimal characters)
[AT]CC YYYY (where YYYY is an integer, up to 32 bits)

[ATINI "Node ID String" (where quotes contain string data)

Enter AT Command:

Appendix D provides additional configuration information if you experience conflicts while
doing development simultaneously with more than one ZigBee coordinator, or if you wish to
install new firmware. Different firmware must be installed to use the RCM4510W as either a
coordinator or as an end device.
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2.4 Where Do | Go From Here?

If the sample program ran fine, you are now ready to go on to the sample programs in Chapter 3 and
to develop your own applications. The sample programs can be easily modified for your own use.
The user's manual also provides complete hardware reference information and software function calls
for the RCM4510W series of modules and the Prototyping Board.

For advanced development topics, refer to the Dynamic C User’s Manual, also in the online doc-
umentation set. An Introduction to ZigBee provides background information on the ZigBee pro-
tocol, and is available on the CD and on our \Web site.

2.4.1 Technical Support

NOTE: If you purchased your RCM4510W through a distributor or through a Rabbit partner, con-
tact the distributor or partner first for technical support.

If there are any problems at this point:
= Use the Dynamic C Help menu to get further assistance with Dynamic C.

= Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/ and at
www.rabbitcom/forums/.

= Use the Technical Support e-mail form at www.rabbit.com/support/.
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3. RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM4510W (and for all other
Rabbit hardware), you must install and use Dynamic C. This chapter
provides a tour of its major features with respect to the RCM4510W.

3.1 Introduction

To help familiarize you with the RCM4510W modules, Dynamic C includes several sample pro-
grams. Loading, executing, and studying these programs will give you a solid hands-on overview
of the RCM4510W’s capabilities, as well as a quick start with Dynamic C as an application devel-
opment tool.

This chapter provides sample programs that illustrate the digital 1/0 and serial capabilities of the
RCM4510W RabbitCore module. Section 6.2 discusses the sample programs that illustrate the
ZigBee features.

NOTE: The sample programs assume that you have at least an elementary grasp of the C lan-
guage. If you do not, see the introductory pages of the Dynamic C User’s Manual for a sug-
gested reading list.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your module must be plugged in to the Prototyping Board as described in Chapter 2, “Getting
Started.”

2. Dynamic C must be installed and running on your PC.

3. The programming cable must connect the programming header on the module to your PC.
4. Power must be applied to the module through the Prototyping Board.

Refer to Chapter 2, “Getting Started,” if you need further information on these steps.

To run a sample program, open it with the File menu, then compile and run it by pressing F9.

Each sample program has comments that describe the purpose and function of the program. Fol-
low the instructions at the beginning of the sample program.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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3.2 Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the RCM4510W
modules. These programs will be found in the SAMPLES\RCM4500W folder.

= CONTROLLED.C—Demonstrates use of the digital outputs by having you turn LEDs DS2 and
DS3 on the Prototyping Board on or off from the STDIO window on your PC.

Parallel Port B bit 2 = LED DS2
Parallel Port B bit 3 = LED DS3

Once you compile and run CONTROLLED. C, the following display will appear in the Dynamic
C STDIO window.

<¢< Proto-board LEDs e

From PC keyboard:
Select 2z052 or 2z052 to toggle LEDs

4 Press "R To Quit &

Press “2” or “3” on your keyboard to select LED DS2 or DS3 on the Prototyping Board. Then
follow the prompt in the Dynamic C STDIO window to turn the LED ON or OFF. A logic low
will light up the LED you selected.

= FLASHLED1.C—demonstrates the use of assembly language to flash LEDs DS2 and DS3 on
the Prototyping Board at different rates. Once you have compiled and run this program, LEDs
DS2 and DS3 will flash on/off at different rates.

= FLASHLED2.C—demonstrates the use of cofunctions and costatements to flash LEDs DS2
and DS3 on the Prototyping Board at different rates. Once you have compiled and run this pro-
gram, LEDs DS2 and DS3 will flash on/off at different rates.
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= TAMPERDETECTION.C—demonstrates how to detect an attempt to enter the bootstrap mode.
When an attempt is detected, the battery-backed onchip-encryption RAM on the Rabbit 4000
is erased. This battery-backed onchip-encryption RAM can be useful to store data such as an
AES encryption key from a remote location.

This sample program shows how to load and read the battery-backed onchip-encryption RAM
and how to enable a visual indicator.

Once this sample is compiled and running (you pressed the F9 key while the sample program
Is open), remove the programming cable and press the reset button on the Prototyping Board to
reset the module. LEDs DS2 and DS3 will be flashing on and off.

Now press switch S2 to load the battery-backed RAM with the encryption key. The LEDs are
now on continuously. Notice that the LEDs will stay on even when you press the reset button
on the Prototyping Board.

Reconnect the programming cable briefly and unplug it again to simulate an attempt to access
the onchip-encryption RAM. The LEDs will be flashing because the battery-backed onchip-
encryption RAM has been erased. Notice that the LEDs will continue flashing even when you
press the reset button on the Prototyping Board.

You may press switch S2 again and repeat the last steps to watch the LEDs.

= TOGGLESWITCH.C—demonstrates the use of costatements to detect switch presses using the
press-and-release method of debouncing. LEDs DS2 and DS3 on the Prototyping Board are
turned on and off when you press switches S2 and S3. S2 and S3 are controlled by PB4 and
PB5 respectively.

Once you have loaded and executed these five programs and have an understanding of how
Dynamic C and the RCM4510W modules interact, you can move on and try the other sample pro-
grams.
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3.2.1 Serial Communication
The following sample programs are found in the SAMPLES\RCM4500W\SERIAL folder.

= FLOWCONTROL .C—This program demonstrates how to configure Serial Port D for CTS/RTS
flow control with serial data coming from Serial Port C (TxC) at 115,200 bps. The serial data
received are displayed in the STDIO window.

To set up the Prototyping Board, you will need to tie TxD and RxD together
on the RS-232 header at J4, and you will also tie TxC and RxC together using | e zc
the jumpers supplied in the Development Kit as shown in the diagram. J4

TxD RxD GND

A repeating triangular pattern should print out in the STDIO window. The pro-
gram will periodically switch flow control on or off to demonstrate the effect
of flow control.

If you have two Prototyping Boards with modules, run this sample program on the sending
board, then disconnect the programming cable and reset the sending board so that the module
is operating in the Run mode. Connect TxC, TxD, and GND on the sending board to RxC,
RxD, and GND on the other board, then, with the programming cable attached to the other
module, run the sample program.

= PARITY.C—This program demonstrates the use of parity modes by repeat-
edly sending byte values 0127 from Serial Port C to Serial Port D. The pro- RICTXC
gram will switch between generating parity or not on Serial Port C. Serial Port |z offc o J4
D will always be checking parity, so parity errors should occur during every oo e
other sequence.

To set up the Prototyping Board, you will need to tie TxC and RxD together on the RS-232
header at J4 using one of the jumpers supplied in the Development Kit as shown in the dia-
gram.

The Dynamic C STDIO window will display the error sequence.

= SERDMA.C—This program demonstrates using DMA to transfer data from a circular buffer to
the serial port and vice versa. The Dynamic C STDIO window is used to view or clear the buffer.

Before you compile and run the sample program, you will need

to connect the RS-232 header at J4 to your PC as shown in the
diagram using the serial to DB9 cable supplied in the Develop- Colored

ment Kit. edge

Once you have compiled and run the sample program, start Tera
Term or another terminal emulation program to connect to the
selected PC serial port at a baud rate of 115,200 bps. You can
observe the output in the Dynamic C STDIO window as you type
in Tera Term, and you can also use the Dynamic C STDIO win-
dow to clear the buffer.

o |RxC

N

[_INe]

o]
RxD |0 O|TxC

O O

TxD
GND [© ©

The Tera Term utility can be downloaded from hp.vec-
tor.co.jp/authors/\VVA002416/teraterm.html.
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= SIMPLE3WIRE.C—This program demonstrates basic RS-232 serial commu-
nication. Lower case characters are sent on TxC, and are received by RxD. RXC TxC
The received characters are converted to upper case and are sent out on TxD, D J4
are received on RxC, and are displayed in the Dynamic C STDIO window. T

To set up the Prototyping Board, you will need to tie TxD and RxC together
on the RS-232 header at J4, and you will also tie RxD and TxC together using the jumpers sup-
plied in the Development Kit as shown in the diagram.

e SIMPLESWIRE.C—This program demonstrates 5-wire RS-232 serial communication with
flow control on Serial Port D and data flow on Serial Port C.

To set up the Prototyping Board, you will need to tie TxD and RxD together
on the RS-232 header at J4, and you will also tie TxC and RxC together using | e e
the jJumpers supplied in the Development Kit as shown in the diagram. J4

TxD RxD GND

Once you have compiled and run this program, you can test flow control by
disconnecting the TxD jumper from RxD while the program is running. Char-
acters will no longer appear in the STDIO window, and will display again once TxD is con-
nected back to RxD.

If you have two Prototyping Boards with modules, run this sample program on the sending
board, then disconnect the programming cable and reset the sending board so that the module
is operating in the Run mode. Connect TxC, TxD, and GND on the sending board to RxC,
RxD, and GND on the other board, then, with the programming cable attached to the other
module, run the sample program. Once you have compiled and run this program, you can test
flow control by disconnecting TxD from RxD as before while the program is running. Since the
J4 header locations on the two Prototyping Boards are connected with wires, there are no slip-on
jumpers at J4 on either Prototyping Board.

= SWITCHCHAR.C—This program demonstrates transmitting and then receiving an ASCII string
on Serial Ports C and D. It also displays the serial data received from both ports in the STDIO
window.

To set up the Prototyping Board, you will need to tie TxD and RxC together
on the RS-232 header at J4, and you will also tie RxD and TxC together using | =« ©xc
the jJumpers supplied in the Development Kit as shown in the diagram. J4

TxD RxD GND

Once you have compiled and run this program, press and release switches S2
and S3 on the Prototyping Board. The data sent between the serial ports will
be displayed in the STDIO window.
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= 10CONFIG_SWITCHECHO.C—This program demonstrates how to set up Serial Ports E and F,
which then transmit and then receive an ASCII string when switch S2 or S3 is pressed. The
echoed serial data are displayed in the Dynamic C STDIO window.

Note that the 1/O lines that carry the Serial Port E and F signals are not the Rabbit 4000
defaults. The Serial Port E and F 1/O lines are configured by calling the library function serkE-
Fconfig() that was generated by the Rabbit 4000 10CONF1G. EXE utility program.

Note that the RCM45_29MHZ_IOCONFIG. LB library generated by 10CONFIG . EXE to sup-
port this sample program is provided in the Dynamic C SAMPLES\RCM4500W\SERIAL folder.

Serial Port E is configured to use Parallel Port E bits PE6 and PE7. These signals are available
on the Prototyping Board's Module Extension Header (header J2).

Serial Port F is configured to use Parallel Port C bits PC2 and PC3. These signals are available
on the Prototyping Board's RS-232 connector (header J4).

Serial Port D is left in its default configuration, using Parallel Port C bits PCO and PC1. These
signals are available on the Prototyping Board's RS-232 connector (header J4). Serial Port D
transmits and then receives an ASCII string with Serial Port F when switch S3 is pressed.

To set up the Prototyping Board, you will need to tie TxC and

RxD together on the RS-232 header at J4 using the jumpers sup- . Jf .

plied in the Development Kit; you will also tie TXE (PE6) and /stu@m

RXE (PE7) together with a soldered wire or with a wire jumper if Es|e ] 7Es J‘z
you have soldered in the IDC header supplied with the accessory com |0 o PooLNZ T0|9 o R
parts in the Development Kit. o o roane N
Once you have compiled and run this program, press and release | e o o) acro

switches S2 or S3 on the Prototyping Board. The data echoed
between the serial ports will be displayed in the STDIO window.
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3.2.2 Real-Time Clock

If you plan to use the real-time clock functionality in your application, you will need to set the
real-time clock. Use the SETRTCKB . C sample program from the Dynamic C SAMPLES\
RTCLOCK folder, and follow the onscreen prompts. The RTC_TEST . C sample program in the
Dynamic C SAMPLES\RTCLOCK folder provides additional examples of how to read and set the

real-time clock.

3.2.3 ZigBee Sample Programs
Section 6.2 describes the sample programs associated with the XBee RF module.
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4. HARDWARE REFERENCE

Chapter 4 describes the hardware components and principal hardware subsys-
tems of the RCM4510W. Appendix A, “RCM4510W Specifications,” pro-
vides complete physical and electrical specifications.

Figure 6 shows the Rabbit-based subsystems designed into the RCM4510W.

32 kHz || 29.49 MHz
osc osc Customer-specific
applications

SRAM RABBIT® CMOS:-level signals
Flash 4000 Level
converter
I
ZigBee Modem with RS-232, RS-485
A/D Converter serial communication
drivers on motherboard
and 1/0
RabbitCore Module

Figure 6. RCM4510W Subsystems
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4.1 RCM4510W Digital Inputs and Outputs
Figure 7 shows the RCM4510W pinouts for headers J1 and J4.

J1 J4
+3.3V_INC]®m o[ 1 GND ADCO/DIOO[_|m o [ ] ADC1/DIO1
/RESET_OUT[ | o o[ ] /IORD ADC2/DIO2[| o © [] ADC3/DIO3
/IOWR[] o o[ J/RESET_IN GND[] o © [ GPIO8/VREF
VBAT EXT[]© o[ 1PAO nc.C]o o[ J+3.3V
PA1C] o o[ 1PA2 SYS PWR_ON[| o o[ GPIOO
PA3[|o o[ ] PA4 GPIO13[|o o[ Jnc.
PASC| o o[ 1 PA6 GPIO15( | o o[ ] GPIO16
PA7[ | o o[ ] PBO/SCLK
PB1/CLKAL 1o o] PB2 n.c. = not connected
PB3|o o[ PB4
PB5|o o[ ]PB6
PB7[ o o[ PCO
PC1]o o[ JPC2
PC3[ | o o[ ] PC4/MOSI
PC5/MISO] o © [ ] PC6/TxA
PC7/RXA o o[ ] PEO
PE1[ |o o[ ] PE2
PE3[ |o ol | PE4
PE5/SMODEO[ ] o o [—] PE6/SMODE1
PE7/STATUS[ ] o o[ ] PDO/LNO
PD1/LN1[| o o[ PD2/LN2
PD3/LN3[| o o[ ] PD4/LN4
PD5/LN5[ | o © [ ] PD6/LN6
PD7/LN7 | o o[ CONVERT
VREF[] o o[ GND
Note: The J1 pinouts are as seen on
the Bottom Side of the module.

Figure 7. RCM4510W Pinout

Headers J1 is a standard 2 x 25 IDC header with a nominal 1.27 mm pitch, and header J4 is a stan-
dard 2 x 7 IDC header with a nominal 2 mm pitch.
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Figure 8 shows the use of the Rabbit 4000 microprocessor ports in the RCM4510W modules.

PBO

PAO-PA7 PB2—PB7 PDO-PD7
Port D
Port A Port B (Rcm4(5)1r(}w only)

PCO, PC2 Port C Port E }“ PEO-PE7
PC1, PC3 (serial Ports C &) | I EUAY:T:T) o

4000
e RES_IN

Serial Ports E & F

PB1, PC6, STATUS Programming Real-Time Clock X
PC7, /RES,: (Sorin Rt AY Watchdog Misc. I/0
SMODEO, SMODE1 11 Timers /RESET_OUT,
PC4, RxD+ ZigBee™ Modem Slave Port ;:85\/%
PC5, TXD- donel et Clock Doubler
RAM Backup Battery Flash
Support

Figure 8. Use of Rabbit 4000 Ports

The ports on the Rabbit 4000 microprocessor used in the RCM4510W are configurable, and so
the factory defaults can be reconfigured. Table 2 lists the Rabbit 4000 factory defaults and the
alternate configurations.
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Table 2. RCM4510W Pinout Configurations

Pin Pin Name Default Use Alternate Use Notes
1 +3.3V_IN
2 GND
Reset output from Reset
3 /RES_OUT Reset output Reset input Generator or external
reset input
4 /IORD Output External 1/0O read strobe
5 /IOWR Output External 1/O write strobe
6 /RESET _IN Input Input to Reset Generator
7 VBAT _EXT Battery input
Slave port data bus
(SD0-SD7)
8-15 PA[O:7 Input/Output
[0:7] npututpu External 1/O data bus
(ID0-1D7)
SCLK
16 PBO Input/Output External 1/0 Address SCLKS (reserved for
future use)
IA6
= SCLKA Programming port
5 |17 PB1 Input/Output External 1/0 Address g gp
< CLKA
S IA7
T
/SWR
18 PB2 Input/Output External 1/0 Address
IA0
/SRD
19 PB3 Input/Output External 1/0 Address
1ALl
SAQ
20 PB4 Input/Output External 1/0 Address
1A2
SAl
21 PB5 Input/Output External 1/0 Address
IA3
/SCS
22 PB6 Input/Output External 1/0 Address
1A4
/SLAVATN
23 PB7 Input/Output External 1/0 Address
IA5
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Table 2. RCM4510W Pinout Configurations (continued)

Pin

Pin Name

Default Use

Alternate Use

Notes

24

PCO

Input/Output

TXD

I/0O Strobe 10
Timer CO
TCLKF

25

PC1

Input/Output

RXD/TXD
1/0 Strobe 11
Timer C1
RCLKF
Input Capture

Serial Port D

26

PC2

Input/Output

TXCITXF
1/0 Strobe 12
Timer C2

27

PC3

Input/Output

RXC/TXCIRXF
I/0O Strobe 13
Timer C3
SCLKD

Input Capture

Serial Port C

28

Header J1

PC4

Input/Output

TXB

1/0 Strobe 14
PWMO
TCLKE

29

PC5

Input/Output

RXB/TXB
I/O Strobe 15
PWM1
RCLKE
Input Capture

Serial Port B (shared by
XBee RF module)

30

PC6

Input/Output

TXA/TXE
1/0 Strobe 16
PWM2

31

PC7

Input/Output

RXAITXAIRXE
I/O Strobe 17
PWM3

SCLKC

Input Capture

Programming port

32

PEO

Input/Output

I/O Strobe 10
A20

Timer CO
TCLKF
INTO
QRD1B
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Table 2. RCM4510W Pinout Configurations (continued)

Pin

Pin Name

Default Use

Alternate Use

Notes

33

PE1

Input/Output

I/0O Strobe 11
A21

Timer C1
RXD/RCLKF
INT1
QRD1A
Input Capture

34

PE2

Input/Output

I/0O Strobe 12
A22

Timer C2
TXF
DREQO
QRD2B

35

PE3

Input/Output

I/0O Strobe 13

A23

Timer C3
RXC/RXF/SCLKD
DREQ1

QRD2A

Input Capture

Header J1

36

PE4

Input/Output

1/0 Strobe 14
/A0

INTO
PWMO
TCLKE

37

PE5/SMODEQ

Input/Output

I/O Strobe 15
INT1

PWM1
RXB/RCLKE
Input Capture

PE5 is the default
configuration

38

PE6/SMODE1

Input/Output

I/O Strobe 16
PWM2

TXE
DREQO

PES6 is the default
configuration

39

PE7/STATUS

Input/Output

I/O Strobe 17
PWM3
RXA/RXE/SCLKC
DREQ1

Input Capture

PE7 is the default
configuration
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Table 2. RCM4510W Pinout Configurations (continued)

Pin

Pin Name

Default Use

Alternate Use

Notes

40

PDO

Input/Output

1/0 Strobe 10
Timer CO

D8

INTO
SCLKD/TCLKF
QRD1B

41

PD1

Input/Output

A6

I/0O Strobe 11
Timer C1

D9

INT1
RXD/RCLKF
QRD1A
Input Capture

42

PD2

Input/Output

1/0 Strobe 12
Timer C2
D10

DREQO
TXF/SCLKC
QRD2B

Header J1

43

PD3

Input/Output

IA7

I/O Strobe 13
Timer C3
D11

DREQ1
RXC/RXF
QRD2A
Input Capture

44

PD4

Input/Output

I/O Strobe 14
D12

PWMO
TXB/TCLKE

45

PD5

Input/Output

A6

I/O Strobe 15
D13

PWM1
RXB/RCLKE
Input Capture

RCM4510W only
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Table 2. RCM4510W Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes
I/O Strobe 16
D14
46 PD6 Input/Output
npuviuteu PWM?2
TXA/TXE
IA7 Serial Port E
1/O Strobe 17 (RCM4510W only)
—
- D15
5 |47 PD7 Input/Output
g PR PWM3
T RXA/RXE
Input Capture
48 CONVERT Analog Input
Reserved for future use
49 VREF Analog reference
voltage
50 GND Ground Ground
1 ADCO0/DIO0 Input/Output Analog Input Software-selectable
2 ADC1/DIO1 Input/Output Analog Input Software-selectable
3 ADC2/DI102 Input/Output Analog Input Software-selectable
4 ADC3/DIO3 Input/Output Analog Input Software-selectable
5 GND Ground
Analog reference voltage Software-selectable,
6 GPIO8/VREF | Input/Output g g analog ref. voltage not
1.2vVv)
presently supported
< 7 n.c.
3z |8 +3.3V
3
T Used by XBee RF
module to place or
9 SYS_PWR_ON | Output remove remaining
RCM4510W circuitry in
“sleep” mode
10 GPIO0 Input/Output
1 GPIO13 Input/Output
12 n.c.
13 GPI0O15 Input/Output
14 GPIO16 Input/Output
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4.1.1 Memory I/O Interface

The Rabbit 4000 address lines (A0-A19) and all the data lines (D0-D7) are routed internally to
the onboard flash memory and SRAM chips. 1/0 write (/IOWR) and 1/0 read (/IORD) are avail-
able for interfacing to external devices, and are also used by the RCM4510W.

Parallel Port A can also be used as an external 1/O data bus to isolate external 1/0 from the main
data bus. Parallel Port B pins PB2—-PB?7 can also be used as an auxiliary address bus.

When using the external 1/0 bus for any reason, you must add the following line at the beginning
of your program.

#define PORTA_AUX_ 10 // required to enable external 1/0 bus

Selected pins on Parallel Ports D and E as specified in Table 2 may be used for input capture,
quadrature decoder, DMA, and pulse-width modulator purposes.

4.1.2 Other Inputs and Outputs

The STATUS and the two SMODE pins, SMODEOQ and SMODEL1, can be brought out to header
J1 instead of the PE5—-PE7 pins as explained in Appendix A.6.

/RESET _IN is normally associated with the programming port, but may be used as an external
input to reset the Rabbit 4000 microprocessor and the RCM4510W memory. /RESET_OUT is an
output from the reset circuitry that can be used to reset other peripheral devices.

4.1.3 Auxiliary 110

Up to nine additional digital 1/O, up to four of which may be configured in software as analog
inputs, a +3.3 V DC power supply point and ground, and a SYS_PWR_ON line are brought out
on auxiliary 1/0O header J4. Section 4.4 describes the use of these lines in more detail.
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4.2 Serial Communication

The RCM4510W module does not have any serial driver or receiver chips directly on the board.
However, a serial interface may be incorporated on the board the RCM4510W is mounted on. For
example, the Prototyping Board has an RS-232 transceiver chip.

4.2.1 Serial Ports

There are six serial ports designated as Serial Ports A, B, C, D, E, and F. All six serial ports can
operate in an asynchronous mode up to the baud rate of the system clock divided by 8. An asyn-
chronous port can handle 7 or 8 data bits. A 9th bit address scheme, where an additional bit is sent
to mark the first byte of a message, is also supported.

Serial Port A is normally used as a programming port, but may be used either as an asynchronous
or as a clocked serial port once application development has been completed and the RCM4510W
is operating in the Run Mode.

Serial Port B is shared with the RCM4510W module’s asynchronous XBee RF module. Flow
control for the XBee RF module is provided from the Rabbit 4000 RxD+ and TxD- Ethernet pins.

Serial Ports C and D can also be operated in the clocked serial mode. In this mode, a clock line
synchronously clocks the data in or out. Either of the two communicating devices can supply the
clock. Note that PD2 and PDO provide the SCLKC and SCLKD outputs automatically when
Serial Ports C and D are set up as clocked serial ports.

Serial Ports E and F can also be configured as SDLC/HDLC serial ports. The IrDA protocol is
also supported in SDLC format by these two ports. Serial Ports E and F must be configured
before they can be used. The sample program 10CONFIG_SWITCHECHO.C in the Dynamic C
SAMPLES\RCM4500W\SERIAL folder shows how to configure Serial Ports E and F.
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Table 3 summarizes the possible parallel port pins for the serial ports and their clocks.

Table 3. Rabbit 4000 Serial Port and Clock Pins

TXA PC6, PC7, PD6 TXE PD6, PE6, PC6
Serial Port A RXA PC7, PD7, PE7 RXE PD7, PE7, PC7
Serial Port E
SCLKA PB1 RCLKE PD5, PE5, PC5
TXB PC4, PC5, PD4 TCLKE PD4, PE4, PC4
Serial Port B RXB PC5, PD5, PE5 TXF PD2, PE2, PC2
SCLKB PBO RXF PD3, PE3, PC3
Serial Port F
TXC PC2, PC3 RCLKF PD1, PE1, PC1
Serial Port C RXC PC3, PD3, PE3 TCLKF PDO, PEO, PCO
SCLKC PD2, PE2, PE7, PC7
TXD PCO, PC1 RCLKE and RCLKF must be selected to be on the
Serial Port D RXD PC1. PD1. PE1 same parallel port as TXE and TXF respectively.
SCLKD PDO, PEO, PE3, PC3

4.2.1.1 Using the Serial Ports

The receive lines on the RCM4510W serial ports do not have pull-up resistors. If you are using
the serial ports without a receiver chip (for example, for RS-422, RS-232, or RS-485 serial com-
munication), the absence of a pull-up resistor on the receive line will likely lead to line breaks
being generated since line breaks are normally generated whenever the receive line is pulled low.
If you are operating a serial port asynchronously, you can inhibit character assembly during
breaks by setting bit 1 in the corresponding Serial Port Extended Register to 1. Should you need
line breaks, you will have to either add a pull-up resistor on your motherboard or use a receiver
that incorporates the circuits to have the output default to the nonbreak levels.

The Dynamic C RS232. LIB library requires you to define the macro RS232_
NOCHARASSY INBRK to inhibit break-character assembly for all the serial ports.

#define RS232_NOCHARASSY INBRK

This macro is already defined so that it is the default behavior for the sample programs in the
Dynamic C SAMPLES\RCM4500W\SERIAL folder.
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4.2.2 Programming Port

The RCM4510W is programmed via the 10-pin header labeled J2. The programming port uses the
Rabbit 4000’s Serial Port A for communication. Dynamic C uses the programming port to down-
load and debug programs.

Serial Port A is also used for the following operations.
= Cold-boot the Rabbit 4000 on the RCM4510W after a reset.

= Fast copy designated portions of flash memory from one Rabbit-based board (the master) to
another (the slave) using the Rabbit Cloning Board.

Alternate Uses of the Programming Port

All three Serial Port A signals are available as

= asynchronous serial port

= an asynchronous serial port, with the clock line usable as a general CMOS 1/0 pin

The programming port may also be used as a serial port via the DIAG connector on the program-
ming cable.

In addition to Serial Port A, the Rabbit 4000 startup-mode (SMODEO, SMODEL1), STATUS, and
reset pins are available on the programming port.

The two startup-mode pins determine what happens after a reset—the Rabbit 4000 is either cold-
booted or the program begins executing at address 0x0000.

The status pin is used by Dynamic C to determine whether a Rabbit microprocessor is present.
The status output has three different programmable functions:

1. It can be driven low on the first op code fetch cycle.
2. It can be driven low during an interrupt acknowledge cycle.

3. It can also serve as a general-purpose output once a program has been downloaded and is run-
ning.

The reset pin is an external input that is used to reset the Rabbit 4000.

Refer to the Rabbit 4000 Microprocessor User’s Manual for more information.
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4.3 Programming Cable

The programming cable is used to connect the programming port of the RCM4510W to a PC
serial COM port. The programming cable converts the RS-232 voltage levels used by the PC
serial port to the CMOS voltage levels used by the Rabbit 4000.

When the PROG connector on the programming cable is connected to the RCM4510W program-
ming port, programs can be downloaded and debugged over the serial interface.

The DIAG connector of the programming cable may be used on header J2 of the RCM4510W with
the RCM4510W operating in the Run Mode. This allows the programming port to be used as a
regular serial port.

4.3.1 Changing Between Program Mode and Run Mode

The RCM4510W is automatically in Program Mode when the PROG connector on the program-
ming cable is attached, and is automatically in Run Mode when no programming cable is
attached. When the Rabbit 4000 is reset, the operating mode is determined by the status of the
SMODE pins. When the programming cable’s PROG connector is attached, the SMODE pins are
pulled high, placing the Rabbit 4000 in the Program Mode. When the programming cable’s
PROG connector is not attached, the SMODE pins are pulled low, causing the Rabbit 4000 to
operate in the Run Mode.

Figure 9. Switching Between Program Mode and Run Mode
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A program “runs” in either mode, but can only be downloaded and debugged when the
RCM4510W is in the Program Mode.

Refer to the Rabbit 4000 Microprocessor User’s Manual for more information on the programming
port.

4.3.2 Standalone Operation of the RCM4510W

Once the RCM4510W has been programmed successfully, remove the programming cable from
the programming connector and reset the RCM4510W. The RCM4510W may be reset by cycling,
the power off/on or by pressing the RESET button on the Prototyping Board. The RCM4510W
module may now be removed from the Prototyping Board for end-use installation.

CAUTION: Power to the Prototyping Board or other boards should be disconnected when
removing or installing your RCM4510W module to protect against inadvertent shorts across the
pins or damage to the RCM4510W if the pins are not plugged in correctly. Do not reapply
power until you have verified that the RCM4510W module is plugged in correctly.
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4.4 Auxiliary I/O
4.4.1 Digital I/O

The RCM4510W modules’ XBee RF module has up to five general-purpose 1/0 on header J4 —
GPIOO0, GPIO8, GPI1013, GPI015, and GP1016. Table 4 provides the names used in Dynamic C
for these pins and their default configurations.

Table 4. XBee RF Module GPIO Pin Setup

J4 Pin Schematic Name Dynamic C Name Default Configuration
10 GPI10O0 DIO_05 Digital Output (high)
6 GPI108 DIO 12 Digital Input (pulled up)
11 GPI1013 DIO_04 Digital Output (high)
13 GPI015 DI0_10 Digital Output (high)
14 GPIO16 DIO 11 Digital Input (pulled up)

All the pins have the following software-configurable features.

= Selectable as input or output.

= Output is either sinking or sourcing, and may be set up for a default high or low.
= Can be pulled up internally.

The four digital 1/0, DIO0-DIO3, are similar to the general-purpose 1/0, but may instead by con-
figured in software as analog inputs.

NOTE: The XBee firmware associated with Dynamic C v. 10.46 does not support 1/O reads for
RCM4510W RabbitCore modules set up as API coordinators or as API routers.

The input switching threshold between logic 0 and logic 1 is 0.66-2.64 V DC, and the output
switching threshold between logic 0 and logic 1 is 0.59-2.71 V DC.
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4.4.2 A/D Converter

The RCM4510W modules’ XBee RF module has four inputs on header J4 that may be set up in
software as analog inputs.

The four analog input pins, ADC0-ADC3, each have an input impedance of 6—7 MQ, depending
on whether they are used as single-ended or differential inputs. The input signal can range from -
1.2 V to +1.2 V (differential mode) or from 0 V to +1.2 V (single-ended mode).

Use a resistor divider such as the one shown in Figure 10 to measure voltages above 1.2 V on the
analog inputs.

RO

— AAA ADC
ADCO (RCM4510W
ADC1 —— AN/ ’ ZigBee [ 1=

RO modem)

R1 R1

—
——

VREF

AGND =

‘\}_

Figure 10. Resistor Divider Network for Analog Inputs

The R1 resistors are typically 20 kQ2 to 100 kQ, with a lower resistance leading to more accuracy,
but at the expense of a higher current draw. The RO resistors would then be 180 kQ to 900 k2 for
a 10:1 attenuator. The capacitor filters noise pulses on the A/D converter input.

The A/D converter can only accept positive voltages. With the R1 resistors connected to ground,
your analog circuit is well-suited to perform positive A/D conversions. When the R1 resistors are
tied to ground for differential measurements, both differential inputs must be referenced to analog
ground, and both inputs must be positive with respect to analog ground.
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If a device such as a battery is con-
nected across two channels for a differ-
ential measurement, and it is not
referenced to analog ground, then the
current from the device will flow
through both sets of attenuator resistors
without flowing back to analog ground
as shown in Figure 11. This will gener-
ate a negative voltage at one of the
inputs, ADC1, which will almost cer-
tainly lead to inaccurate A/D conver-
sions. To make such differential
measurements, connect the R1 resistors
to the A/D converter’s internal reference voltage, which is 1.2 V. This internal reference voltage
can be configured in software to be available on pin 6 of header J4 as VREF, and allows you to
convert analog input voltages that are negative with respect to analog ground.

ADCO ADC

ADC1

Figure 11. Current Flow from Ungrounded
or Floating Source

NOTE: This software configuration option for VREF and differential measurements are not sup-
ported at this time.

NOTE: The amplifier inside the A/D converter’s internal voltage reference circuit has a very lim-
ited output-current capability. The internal buffer can source up to 20 mA and sink only up to
20 pA. Use a separate buffer amplifier if you need to supply any load current.

4.4.3 Other Pin Features
There are two other features brought out on the auxiliary 1/0 header J4.

e Thereis a +3.3 V power supply point on pin 8, which can deliver up to 25 mA at 3.3 V DC.
This power supply point is essentially a filtered and isolated version of the regulated +3.3 V
DC power that is supplied to the RCM4510W RabbitCore module through pin 1 of header J1
from the motherboard.

e The SYS_PWR_ON signal on pin 9 is used by the XBee RF module to place the remaining cir-
cuitry on the RCM4510W RabbitCore module into a powered-down “sleep” mode or to bring
it back up to normal operation.
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4.5 Other Hardware
4.5.1 Clock Doubler
The clock doubler on the RCM4510W is disabled by default.

4.5.2 Spectrum Spreader

The Rabbit 4000 features a spectrum spreader, which helps to mitigate EMI problems. The spec-
trum spreader is on by default, but it may also be turned off or set to a stronger setting. The means
for doing so is through a simple configuration macro as shown below.

1. Select the “Defines” tab from the Dynamic C Options > Project Options menu.

2. Normal spreading is the default, and usually no entry is needed. If you need to specify
normal spreading, add the line

ENABLE_SPREADER=1
For strong spreading, add the line
ENABLE_SPREADER=2
To disable the spectrum spreader, add the line
ENABLE_SPREADER=0
NOTE: The strong spectrum-spreading setting is not recommended since it may limit

the maximum clock speed or the maximum baud rate. It is unlikely that the strong set-
ting will be used in a real application.

3. Click OK to save the macro. The spectrum spreader will be set according to the macro
value whenever a program is compiled using this project file.

NOTE: Refer to the Rabbit 4000 Microprocessor User’s Manual for more information on the
spectrum-spreading setting and the maximum clock speed.
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4.6 Memory

4.6.1 SRAM

All RCM4510W modules have 512K of battery-backed data SRAM installed at U4.
4.6.2 Flash EPROM

All RCM4510W modules also have 512K of flash EPROM installed at U3.

NOTE: Rabbit recommends that any customer applications should not be constrained by the sec-
tor size of the flash EPROM since it may be necessary to change the sector size in the future.

Writing to arbitrary flash memory addresses at run time is discouraged. Instead, define a “user
block” area to store persistent data. The functions writeUserBlock and readUserBlock
are provided for this. Refer to the Rabbit 4000 Microprocessor Designer’s Handbook for additional
information.
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5. SOFTWARE REFERENCE

Dynamic C is an integrated development system for writing embedded
software. It runs on an IBM-compatible PC and is designed for use
with single-board computers and other devices based on the Rabbit
microprocessor. Chapter 5 describes the libraries and function calls
related to the RCM4510W.

5.1 More About Dynamic C

Dynamic C has been in use worldwide since 1989. It is specially designed for programming
embedded systems, and features quick compile and interactive debugging. A complete reference
guide to Dynamic C is contained in the Dynamic C User’s Manual.

You have a choice of doing your software development in the flash memory or in the static
SRAM included on the RCM4510W. The flash memory and SRAM options are selected with the
Options > Program Options > Compiler menu.

The advantage of working in RAM is to save wear on the flash memory, which is limited to about
100,000 write cycles. The disadvantage is that the code and data might not both fit in RAM.

NOTE: Do not depend on the flash memory sector size or type in your program logic. The
RCM4510W and Dynamic C were designed to accommaodate flash devices with various sector
sizes in response to the volatility of the flash-memory market.

Developing software with Dynamic C is simple. Users can write, compile, and test C and assem-
bly code without leaving the Dynamic C development environment. Debugging occurs while the
application runs on the target. Alternatively, users can compile a program to an image file for later
loading. Dynamic C runs on PCs under Windows NT and later—see Rabbit’s Technical Note
TN257, Running Dynamic C® With Windows Vista®, for additional information if you are using a
Dynamic C under Windows Vista. Programs can be downloaded at baud rates of up to 460,800
bps after the program compiles.
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Dynamic C has a number of standard features.

= Full-feature source and/or assembly-level debugger, no in-circuit emulator required.
= Royalty-free TCP/IP stack with source code and most common protocols.

= Hundreds of functions in source-code libraries and sample programs:

P Exceptionally fast support for floating-point arithmetic and transcendental functions.
P RS-232 and RS-485 serial communication.
» Analog and digital I/O drivers.

» 12C, SPI, GPS, file system.
P LCD display and keypad drivers.
= Powerful language extensions for cooperative or preemptive multitasking

= Loader utility program to load binary images into Rabbit targets in the absence of Dynamic C.

= Provision for customers to create their own source code libraries and augment on-line help by
creating “function description” block comments using a special format for library functions.

= Standard debugging features:

P Breakpoints—Set breakpoints that can disable interrupts.
P Single-stepping—Step into or over functions at a source or machine code level, uC/OS-I1 aware.

P Code disassembly—The disassembly window displays addresses, opcodes, mnemonics, and machine cycle
times. Switch between debugging at machine-code level and source-code level by simply opening or closing
the disassembly window.

P Watch expressions—Watch expressions are compiled when defined, so complex expressions including
function calls may be placed into watch expressions. Watch expressions can be updated with or without
stopping program execution.

P Register window—All processor registers and flags are displayed. The contents of general registers may be
modified in the window by the user.

P Stack window—shows the contents of the top of the stack.
» Hex memory dump—displays the contents of memory at any address.

P STDIO window—printf outputs to this window and keyboard input on the host PC can be detected for
debugging purposes. printf output may also be sent to a serial port or file.
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5.2 Dynamic C Function Calls
5.2.1 Digital I/O

The RCM4510W was designed to interface with other systems, and so there are no drivers written
specifically for the Rabbit 4000 1/O. The general Dynamic C read and write functions allow you
to customize the parallel 1/0 to meet your specific needs. For example, use

WrPortl (PEDDR, &PEDDRShadow, 0x00);
to set all the Port E bits as inputs, or use
WrPortl (PEDDR, &PEDDRShadow, OXFF);

to set all the Port E bits as outputs.
When using the external 1/0 bus on the Rabbit 4000 chip, add the line
#define PORTA_AUX_IO  // required to enable external 1/0 bus
to the beginning of any programs using the external 1/0O bus.
The sample programs in the Dynamic C SAMPLES/RCM4500W folder provide further examples.
5.2.2 Serial Communication Drivers

Library files included with Dynamic C provide a full range of serial communications support.
The RS232.LIB library provides a set of circular-buffer-based serial functions. The

PACKET . LB library provides packet-based serial functions where packets can be delimited by the
9th bit, by transmission gaps, or with user-defined special characters. Both libraries provide
blocking functions, which do not return until they are finished transmitting or receiving, and non-
blocking functions, which must be called repeatedly until they are finished, allowing other func-
tions to be performed between calls. For more information, see the Dynamic C Function
Reference Manual and Technical Note TN213, Rabbit Serial Port Software.

5.2.3 User Block

Certain function calls involve reading and storing calibration constants from/to the simulated
EEPROM in flash memory located at the top 2K of the reserved user block memory area (3800—
39FF). This leaves the address range 0-37FF in the user block available for your application.

These address ranges may change in the future in response to the volatility in the flash memory
market, in particular sector size. The sample program USERBLOCK_INFO.C in the Dynamic C
SAMPLES\USERBLOCK folder can be used to determine the version of the ID block, the size of
the ID and user blocks, whether or not the ID/user blocks are mirrored, the total amount of flash
memory used by the ID and user blocks, and the area of the user block available for your applica-
tion.

The USERBLOCK_CLEAR . C sample program shows you how to clear and write the contents of
the user block that you are using in your application (the calibration constants in the reserved area
and the ID block are protected).
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5.2.4 SRAM Use

The RCM4510W module has a battery-backed data SRAM and a program-execution SRAM.
Dynamic C provides the protected keyword to identify variables that are to be placed into the
battery-backed SRAM. The compiler generates code that maintains two copies of each protected
variable in the battery-backed SRAM. The compiler also generates a flag to indicate which copy of
the protected variable is valid at the current time. This flag is also stored in the battery-backed
SRAM. When a protected variable is updated, the “inactive” copy is modified, and is made
“active” only when the update is 100% complete. This assures the integrity of the data in case a
reset or a power failure occurs during the update process. At power-on the application program
uses the active copy of the variable pointed to by its associated flag.

The sample code below shows how a protected variable is defined and how its value can be
restored.

main() {
protected int statel, state2, state3;

_syslsSoftReset(); // restore any protected variables

Additional information on protected variables is available in the Dynamic C User’s Manual.
5.2.5 RCM4510W Cloning

The RCM4510W does not have a pull-up resistor on the PB1 (CLKA) line of the programming
port. Because of this, the procedure to generate clones from the RCM4510W differs from that
used for other RabbitCore modules and single-boards computers. You must set the CL_FORCE_
MASTER_MODE macro to 1 in the Dynamic C L1B\Rabbit4000\BI10SLIB\CLONECONFIG.LIB
library to use the RCM4510W as a master for cloning. An RCM4510W master will not run the
application, and further debugging is not possible as long as the CL_FORCE_MASTER_MODE
macro is set to 1. Any cloned RCM4510W modules will be “sterile,” meaning that they cannot be
used as a master for cloning. To develop and debug an application on an RCM4510W, comment
out the CL_FORCE_MASTER_MODE macro or set it to 0.

NOTE: Instead of defining this macro is your application, you may simply add the line CL_
FORCE_MASTER_MODE=1 under the Dynamic C Options > Project Options “Defines”
tab, then click OK. When you recompile your program, this will have the same effect as setting
the macro to 1 within the CLONECONFIG.LIB library.

See Technical Note TN207, Rabbit Cloning Board, for additional information on Rabbit’s clon-
ing board and how cloning is done.
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5.2.5.1 Including Firmware Update in Cloned Application

If you include the firmware update in the master RCM4510W program, clone this program to an
RCM4510W clone, and then let that program run on the clone, then the firmware update will fail
unless you remove the cloning cable from the clone before the firmware update begins.

To avoid this failure, Rabbit recommends that you include code in the master program that is to
be cloned to check the firmware version when the RCM4510W resets or boots up. The reset or
boot-up will happen as a matter of course once the cloning cable is removed and the RCM4510W
clone operates in the Run Mode for the first time. The firmware version can be checked by calling
xbee_init() — if an error returns, the firmware update will happen successfully since the
cloning cable is no longer attached, and if there is no error returned, the firmware is already up-
to-date and the RCM4510W clone will reset or boot up normally.

5.2.6 ZigBee Drivers

The ZigBee drivers are located in the L1B\Rabbi t4000\XBee folder. Complete information on
these libraries and the ZigBee function calls is provided in Section 6.4.
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5.2.7 Prototyping Board Function Calls

The function calls described in this section are for use with the Prototyping Board features. The
source code is in the Dynamic C L1B\Rabbit4000\RCM4xxx\RCM45xxW . L 1B library if you
need to modify it for your own board design.

Other generic functions applicable to all devices based on Rabbit microprocessors are described
in the Dynamic C Function Reference Manual.

5.2.7.1 Board Initialization

brdInit

void brdInit(void);

DESCRIPTION

Call this function at the beginning of your program. This function initializes Parallel Ports A
through E for use with the Prototyping Board.

Summary of Initialization
1. 1/O port pins are configured for Prototyping Board operation.
2. Unused configurable 1/O are set as tied outputs.
3. RS-232 is not enabled.
4. LEDs are off.
5

. The slave port is disabled.

RETURN VALUE
None.
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5.2.7.2 Alerts

These function calls can be found in the Dynamic C L1B\Rabb i t4000\RCM4xxx\
RCM4xxx . L1B library.

timedAlert

void timedAlert(unsigned long timeout);

DESCRIPTION

Polls the real-time clock until a timeout occurs. The RCM4510W will be in a low-power mode
during this time. Once the timeout occurs, this function call will enable the normal power
source.

PARAMETER
timeout the duration of the timeout in seconds

RETURN VALUE

None.

SEE ALSO
brdInit

diglnAlert

void diglnAlert(int dataport, int portbit, int value, unsigned long
timeout);

DESCRIPTION

Polls a digital input for a set value or until a timeout occurs. The RCM4510W will be in a low-
power mode during this time. Once a timeout occurs or the correct byte is received, this function
call will enable the normal power source and exit.

PARAMETERS
dataport the input port data register to poll (e.g., PADR)
portbit the input port bit (0-7) to poll
value the value of 0 or 1 to receive
timeout the duration of the timeout in seconds (enter 0 for no timeout)

RETURN VALUE
None.
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5.2.8 Auxiliary 1/0 Pins Function Calls

The function calls described in this section are for use with the pins on the auxiliary 1/0 header at
J4. The source code is in the Dynamic C L1B\Rabbit4000\XBee\XBEE_API _LIB library if
you need to modify it for your own board design.

The sample programs in the Dynamic C SAMPLES\XBee folder illustrate the use of the function
calls.

int zb_io_init(void);

DESCRIPTION

Initializes the 1/0O on the XBee RF module. The default behavior for each pin is predefined, but
may be overridden before the #use XBEE_AP1 . LB statement or by calling the appropriate

macro.
.| Dynamic C : : Default Pull-Up Mask
J4 Pin Name Functionality Configuration State Bit
1 p1o_oo | AnalogInputor |,y input | Not Applicable 4
~ Digital 1/0 g7np PP
2 DI0_01 Analog Input or Analog Input Not Applicable 3
— Digital 1/0 ginp PP
3 | Dpioo2 |Analoginputor o input | Not Applicable 2
— Digital 1/0 ginp PP
4 p1o_o3 | Analoginputor |00 input | Not Applicable 1
— Digital 1/0 g hp PP
6 DIO_12 Digital 1/0 Digital Input | Pulled Up 30 kQ 10
10 DIO_05 Digital 1/0 Digital Output Default High 8
11 DIO_04 Digital 1/0 Digital Output Default High 0
13 DIO_10 Digital 1/0 Digital Output Default Low 11
14 DIO_11 Digital 1/0 Digital Input | Pulled Up 30 kQ 12
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zb_10_1Init (cont’d)

The pins are configured as analog inputs or as digital 1/0O using the following macros as exam-
ples before #use XBEE_API.LIB

#define
#define
#define
#define
#define
#define
#define
#define
#define

DI0_00
DI0_01
DI0_02
DI10_03
DIO_12
DI0_05
DIO_04
DI0_10
DIO_11

XBEE_10_CONF_ANAIN //
XBEE_10_CONF_ANAIN //
XBEE_10_CONF_ANAIN //
XBEE_10_CONF_ANAIN //
XBEE_10_CONF_DIGIN //

XBEE_10_CONF_DIGOUT_HIGH //
XBEE_10_CONF_DIGOUT_HIGH //
XBEE_10_CONF_DIGOUT_LOW //
XBEE_10_CONF_DIGIN //

bit
bit
bit
bit
bit
bit
bit
bit
bit

11
12

NOTE: The mask order is different than for DIO_INPUTS. While all pins can be configured as
either inputs or outputs, only DIO_00 - D10 _03 can be configured as analog inputs.

RETURN VALUE

0 — success.

#0 — one of the error codes returned by zb_AP1_ATCmdResponse()
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5.2.8.1 Digital I/O

zb _dio_1in
int zb_dio_in(int dio);
DESCRIPTION
Reads the logic state of a pin configured as a digital input pin. This value corresponds to the
dio number.
PARAMETERS
dio the Dynamic C digital input pin number (0—2ZB_MAX_PIN, valid values

are 0-5, 10-12) setupin zb_io_init().

NOTE: The pin number is not the same as the D10_xx macros described in zb_io_init(),
which are used to configure the function of the pin only.

RETURN VALUE
0 or 1 — logic state.

—EINVAL — error (pin not configured as a digital input).

zb_dio_out

int zb_dio_out(int dio, int value);

DESCRIPTION
Sets the digital output value.

PARAMETERS
dio the Dynamic C digital output pin number (0—ZB_MAX_PIN, valid values
are 0-5, 10-12) setup in zb_io_init().
value the logic level (0 or 1) the pin is set to.

NOTE: The pin number is not the same as the D10_xx macros described in zb_io_init(),
which are used to configure the function of the pin only.

RETURN VALUE
0 — success.

—EINVAL — error (pin not configured as a digital output).
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5.2.8.2 Analog Inputs

zb_adc_i1n

int zb_adc_in(int dio);

DESCRIPTION

Reads the analog input on the designated pin and return its 10-bit value. To convert the reading
to millivolts perform the following calculation.

AD (mV) = (ADIO reading / 1023) x 1200 mV
PARAMETER
dio the Dynamic C analog input pin number (0-3) setup inzb_io_init().

NOTE: The pin number is not the same as the D10_xx macros described in zb_io_init(),
which are used to configure the function of the pin only.

RETURN VALUE
0-1023 — valid data.

—EINVAL — error (pin not configured as an analog input).
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5.3 Upgrading Dynamic C

Dynamic C patches that focus on bug fixes are available from time to time. Check the Web site
www.rabbit.com/support/ for the latest patches, workarounds, and bug fixes.

5.3.1 Add-On Modules

Starting with Dynamic C version 10.40, Dynamic C includes the popular pC/OS-II real-time
operating system, point-to-point protocol (PPP), FAT file system, RabbitWeb, and other select
libraries. Rabbit also offers for purchase the Rabbit Embedded Security Pack featuring the Secure
Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library.

In addition to the Web-based technical support included at no extra charge, a one-year telephone-
based technical support subscription is also available for purchase.

Visit our Web site at www.rabbit.com for further information and complete documentation.
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6. USING THE ZIGBEE FEATURES

6.1 Introduction to the ZigBee Protocol

The ZigBee PRO specification was ratified in April, 2007, and covers high-level communication
protocols for small, low-power digital modems based on the IEEE 802.15.4 standard for wireless
personal area networks (WPANS). The XBee RF module used by the RCM4510W operates in the
2.4 GHz industrial, scientific, and medical (ISM) radio band in most jurisdictions worldwide.

The ZigBee protocol is ideal for embedded-system applications that are characterized by low data
rates and low power consumption. A network of devices using the ZigBee protocol works via a
self-organizing mesh network that can be used for industrial control, embedded sensors, data col-
lection, smoke and intruder warning, and building automation. The power consumption of the
individual device could be met for a year or longer using the originally installed battery.

A ZigBee device can be set up in one of three ways.

= Asa coordinator: The coordinator serves as the root of the network tree. Each network can
only have one coordinator. The coordinator stores information about the network and provides
the repository for security keys.

= As a router. Routers pass data from other devices.

= Asan end device. End devices contain just enough functionality to talk to their parent node
(either the coordinator or a router), and cannot relay data from other devices.

The XBee RF module used by the RCM4510W (ZB) sup-
ports using the RCM4510W RabbitCore module in a mesh
network. RCM4510W modules are preconfigured with
ZNet 2.5 or ZB router firmware — only ZB firmware sup-
ports a mesh network. Coordinator and end-device firm-
ware is included in the Dynamic C installation along with a
sample program to allow you to download the firmware.

The firmware used with the XBee RF modules on the
RCMA4510W modules is based on the APl command set.

Figure 12. Mesh Network

An Introduction to ZigBee provides background information on the ZigBee protocol, and is
available on the CD and on our Web site.
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6.1.1 ZNet vs. ZB Firmware

RCM4510W modules are preconfigured with ZNet 2.5 or ZB router firmware. The firmware pre-
loaded at the factory is indicated with the model number and is reflected in different part numbers
(see Table 1). Older RCM4510W modules shipped with ZNet firmware and do not have a sticker
on their XBee RF module.

@CM451 ow (ZNetD [RC M4510W (ZB)]

= ZNet 2.5 firmware is supported by Dynamic C v. 10.21 and later versions. (Preview versions
of the RCM4510W will work with Dynamic C v. 10.11 and later.)

= ZB firmware is supported by Dynamic C v. 10.46 and later versions.

ZigBee networks developed around the two types of firmware are essentially different networks
that are not compatible with each other. It is possible to migrate an application developed with
ZNet 2.5 firmware to ZB firmware by installing the ZB firmware on the XBee RF module and
recompiling the application using Dynamic C v. 10.46 or later versions.

Some macros prior to Dynamic C v. 10.46 have been deprecated, but will still function with
Dynamic C v. 10.46 or later versions. You can expect to see warning messages in this case. The
only way to avoid this situation is to disable warning messages (not recommended), or to replace
the macros with the new ones. The table below lists some of the commonly used macros.

Original Macro New Macro
ZIGBEE_COORDINATOR | XBEE_ROLE NODE_TYPE_COORD
ZI1GBEE_ROUTER XBEE_ROLE NODE_TYPE_ROUTER
ZI1GBEE_ENDDEV XBEE_ROLE NODE_TYPE_ENDDEV

See Section 6.2.2 for additional information on macros that are specific to the two types of firm-
ware.
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6.2 ZigBee Sample Programs
In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your module must be plugged into the Prototyping Board as described in Chapter 2, “Getting
Started.”

2. Dynamic C must be installed and running on your PC.

3. The programming cable must connect the programming header on the RCM4510W to your
PC.

4. Power must be applied to the module through the Prototyping Board.

5. The Digi® XBee USB used as the ZigBee coordinator must be connected to an available USB
port on your PC if you are exercising the ZigBee protocol, or you need a second RCM4510W
module if so instructed.

Refer to Chapter 2, “Getting Started,” if you need further information on these steps.

To run a sample program, open it with the File menu (if it is not still open), then compile and run
it by pressing F9.

Each sample program has comments that describe the purpose and function of the program. Fol-
low the instructions at the beginning of the sample program.

The sample programs in the Dynamic C SAMPLES\RCM4500W\XBee and SAMPLES\XBee folders
illustrate the use of the XBee function calls.

6.2.1 Setting Up the Digi XBee USB Coordinator

1. Connect the Digi® XBee USB acting as a ZigBee coordinator to an available USB port on your
PC or workstation. Your PC should recognize the new USB hardware.

2. Compile and run the XBEE_GP I10_SERVER . C sample program in the Dynamic C SAMPLES\
RCM4500W\XBee folder.

3. Open the ZigBee Utility by double-clicking XBEE_GP10_GUI .exe in the Dynamic C Utili-
ties\XBee GPI0 GUI folder — if you have problems launching the ZigBee Utility, install a .
Net Framework by double-clicking dotnetfx.exe in the Dynamic C Uti lities\dotnetfx
folder. You may add a shortcut to the ZigBee Utility on your desktop.

4. Confirm the following hardware setup is displayed on the “PC Settings” tab.

* 115200 baud

Hardware flow control
8 data bits

No parity
1 stop bit

Now select the COM port the Digi® XBee USB is connected to, and click the “Open Com
Port” button. The message “Radio Found” is displayed to indicate that you selected the correct
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COM port. The ZigBee parameters (firmware version, operating channel, PAN ID) for the
Digi® XBee USB will be displayed in the “Radio Parameters” box. Go to Control Panel >
System > Hardware > Device Manager > Ports on your PC if you need help in identifying
the USB COM port.

5. Any ZigBee devices discovered will be displayed in the “Devices Discovered” window to the
right.

If the utility times out and no ZigBee devices are displayed, you will have to reconfigure the
Digi® XBee USB and recompile the sample program once you make sure the RCM4510W is
powered up. The timeout may occur if you are doing development simultaneously with more
than one ZigBee coordinator. Appendix D explains the steps to reconfigure the Digi® XBee
USB.

6. Select a device with your mouse pointer and click on the selected device to select that device.
This device will now be displayed in the “Selected Device” area.

PC Settings | Command Window | Messages

Name Value Set Output
(0): DS2 OFF SetON

7. You are now ready to interface with the RCM4510W via the ZigBee protocol. Try pinging the
selected device by clicking the “Send Ping” button.
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6.2.2 Setting up Sample Programs

The sample programs are set up so that the RCM4510W module you are using is a ZigBee end
device, router, or coordinator. Uncomment the line corresponding to the role the RCM4510W will
have once it is running the sample program. The default described in the sample programs is for
the RCM4510W module to be either a router (shown below) or an end device.

// Set XBEE _ROLE to NODE_TYPE_COORD, NODE_TYPE_ROUTER or NODE_TYPE ENDDEV
// to match your XBee"s Ffirmware.
#define XBEE_ROLE  NODE_TYPE_ROUTER

NOTE: Remember that the firmware loaded to the XBee RF module is different depending on
whether the RCM4510 W is an end device/router (default) or a coordinator. See Appendix D,
“Additional Configuration Instructions,” for information on how to download firmware
to the RCM4510W module to set it up as a coordinator or to resume its original configu-
ration as a router (ZigBee PRO) or an end device/router (ZNet 2.5).

There are several macros that may be changed to facilitate your setup. The macros can be
included as part of the program code, or they may be put into the Program Options “Defines” on
the “Defines” tab in the Options > Program Options menu.

7B ZNet 2.5

Extended PAN ID — the 64-bit network ID. | PAN ID — the network ID. Defaults to
Defaults to DEFAULT_PANID if setin the | 0x0234 via the macro in the Dynamic C
Dynamic C LI1B\Rabbit4000\XBee\ LIB\Rabbit4000\XBee\XBEE_API.LIB
XBEE_API . LIB library, otherwise defaults | library. Change the PAN ID if you are

to 0x0123456789abcdef to match the developing simultaneously with more than
default used on the Digi® XBee USB. one ZigBee coordinator.

If set to 0x00, tells coordinators to “selecta | #define DEFAULT_PANID 0x0234
random extended PAN ID,” and tells routers
and end devices to “join any network.”

Change the extended PAN ID if you are
developing simultaneously with more than
one ZigBee coordinator.

#define DEFAULT_EXTPANID
"'0x0123456789abcdef""

Channel mask — defaults to OX1FFE, i.e., all 12 possible channels via the macro in the
Dynamic C LI1B\Rabbit4000\XBee\XBEE_API .LIB library. (Do not use bits 14 and 15 for
campatibility with the XBee PRO.)

#define DEFAULT_CHANNELS XBEE_DEFAULT_CHANNELS
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Node ID — the ID of your particular node via the macro in the Dynamic C LI1B\
Rabbit4000\XBee\XBEE_API .LIB library. Each node should have a unique identifier of up
to 20 printable characters.

 Defaults to Rabb1tXBee.

» Can be set to a global variable, or to a function that returns a pointer to a static buffer.
#define NODEID_STR "'RabbitXBee"

The XBee sample programs in the Dynamic C SAMPLES\XBee folder illustrate the use of AT
commands with the XBee RF module.

e AT_INTERACTIVE.C—This sample program shows how to set up and use AT commands
with the XBee RF module.

The program will print out a list of AT commands in the Dynamic C STDIO window. You may
type in either “ATxx” or just the “xx” part of the command.
» Use just the AT command to read any of the values.

» Use [AT]xx yyyy (where the y is an integer up to 32 bits) to set any of the “set or read” values. (Note that
this works for NI, the node identifier, where the data will be a Node ID.string in quotes — [AT]NI "Node ID
string” where the quotes contain the string data).

Note that you can also use hex notation by prefixing the parameter with Ox and using an even number of hex
characters.

» Type “menu” to redisplay the menu of commands.
* Press F4 to exit and close the STDIO window.

e AT_RUNONCE.C—This sample program uses many of the most important and useful AT com-
mands. Several commands can either set a parameter or read it. This sample program simply
reads the parameters and displays the results.

Compile and run this sample program. The program will display the results in the Dynamic C
STDIO window.
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The XBee sample programs in the Dynamic C SAMPLES\RCM4500W\XBee folder exercise the
XBee function calls on the XBee RF module on the RCM4510W.

e SLEEPMODE .C—This sample program shows how to place the RCM4510W module in the
“sleep”” mode where most power is removed from the RCM4510W module. Power is restored
once a message is received or after a specified time interval. This sample program demon-
strates waking after a specified time interval.

Sleeping only works on end devices, so the XBEE_ROLE macro is set to NODE_TYPE_ENDDEV
in this sample program. Because the XBee RF module turns the Rabbit processor off and on, a
serial terminal emulator is required once the program has been compiled.

1. Compile and run the sample program on the RCM4510W module.

2. Once the sample program is running, choose “Close Connection” from the in Dynamic C Run menu, and
unplug the AC adapter supply power to the Prototyping Board.

3. Connect the DIAG connector instead of the PROG connector on the programming cable to the RCM4510
programming header.

4. Open the serial port in your serial terminal emulator such as TeraTerm or Hyperterminal to connect to the
serial port at 57600 baud.

5. Plug the AC adapter back in to apply power to the Prototyping Board once again.

Once the XBee RF module on the RCM4510W completes its initialization (it joins the net-
work), you will be prompted to enter a “sleep” time in milliseconds — enter the number fol-
lowed by the Enter key. There will be a delay of a few seconds before the RCM4510W
module powers off. When the RCM4510W module powers back up, it will begin running this
program again from the beginning.

NOTE: This sample program does not demonstrate the saving state. State information may be
saved in battery-backed RAM before the RCM4510W module is placed in the sleep mode.
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= SLEEPMODEZ2 .C—This sample program shows how to place the RCM4510W module in the
“sleep”” mode where most power is removed from the RCM4510W module. Power is restored
once a message is received or after a specified time interval. This sample program demon-
strates waking after a specified time interval.

Sleeping only works on end devices, so the XBEE_ROLE macro is set to NODE_TYPE_ENDDEV
in this sample program. Because the XBee RF module turns the Rabbit processor off and on, a
serial terminal emulator is required once the program has been compiled.

1. Compile and run the sample program on the RCM4510W module.

2. Once the sample program is running, choose “Close Connection” from the in Dynamic C Run menu, and
unplug the AC adapter supply power to the Prototyping Board.

3. Connect the DIAG connector instead of the PROG connector on the programming cable to the RCM4510
programming header.

4. Open the serial port in your serial terminal emulator such as TeraTerm or Hyperterminal to connect to the
serial port at 57600 baud.

5. Plug the AC adapter back in to apply power to the Prototyping Board once again.

Once the XBee RF module on the RCM4510W completes its initialization (it joins the net-
work), you will be prompted to enter three values that control the XBee RF module's sleep
mode — enter the values followed by the Enter key each time. Once you have entered these
values via the serial terminal emulator, press any key to initiate the sleep mode. There will be a
delay of a few seconds before the RCM4510W module powers off. When the RCM4510W
module powers back up, it will begin running this program again from the beginning.

NOTE: This sample program does not demonstrate the saving state. State information may be
saved in battery-backed RAM before the RCM4510W module is placed in the sleep mode.

= XBEE_GPI0O_SERVER.C—This sample program shows how to set up and use endpoints and
clusters. It is meant to be run with the Windows GUI client (installed in Dynamic C’s Utili-
ties directory) and a Digi USB XBee coordinator or with the GPIO client sample program
(SAMPLES/XBEE/XBEE_GP10_CLIENT.C) running on an RCM4510W RabbitCore module or
on a single-board computer with a separate XBee RF module.

Compile and run this sample program with the RCM4510W RabbitCore module installed on the
Prototyping Board. Run the Windows GUI client (XBEE_GP10_GUI .exe in the Dynamic C
Utilities\XBee GPI0 GUI folder) on your PC. Configure the GUI client to connect to the
Digi USB XBee coordinator and scan for devices. Make sure the RCM4510W and the Digi
USB XBee coordinator are configured with the same PAN ID or extended PAN ID.

If you run the XBEE_GPI10_CLIENT.C sample program on another board with an XBee RF
module, set the PAN IDs to match between the client and the server sample programs.

Now select the GPIO server and use the GUI interface on the PC, or the command-line client
on another XBee-equipped board to view the server's inputs and change its outputs. For exam-
ple, you can toggle the LEDs on the Prototyping Board on/off.
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6.3 Using the Sleep Mode

The RCM4510W RabbitCore module has two components that are involved when the sleep mode
is invoked — the XBee RF module and the Rabbit 4000 microprocessor.

End devices, unlike coordinators and routers, can enter a low-power sleep mode. This sleep mode
is controlled by the XBee RF module, and fully powers down the Rabbit 4000 microprocessor for
significant savings in power use.

The sleep mode can only be initiated while the RCM4510W is in the Run Mode (see Section 4.3.
1 for more information on the Program Mode and the Run Mode).

Once the XBee RF module on the RCM4510W is operating in the sleep mode, it will periodically
wake up and poll its parent router or coordinator to determine whether there is an incoming mes-
sage. If one is found, the message will be received and the Rabbit 4000 microprocessor will be
restarted. Otherwise the XBee RF module will return to sleep. Depending on how the sleep mode
is configured, the XBee RF module may also restart the Rabbit 4000 microprocessor after a time-
out has passed even if no message is received.

The sleep mode is controlled by the XBee RF module with a set of user-configurable parameters.
Although a parameter can be set with an AT command, the recommended procedure is to only ini-
tiate the sleep mode using either the zb_Rabbit_poweroff() or the xb_sleep() function
call.

The most important parameters are ST, SP, and SN. Together they control the duration of sleep
and wake times.

= ST is measured in milliseconds, and controls the amount of time the XBee RF module, and
consequently the Rabbit microprocessor, will stay awake waiting for RF or serial data before
going to sleep. If any data are received, the ST counter will be reset. The Rabbit 4000 micro-
processor needs approximately two seconds to boot and reinitialize the XBee RF module, so
the value of ST must be at least 2000.

= SPis measured in 0.01 second intervals and controls the length of sleep for the XBee RF mod-
ule. The XBee RF module will operate in a low-power mode for the time specified in SP, and
then wake up briefly to poll its parent for a message. Depending on the value of SN, the XBee
RF module may then either return to sleep or wake up the Rabbit 4000 microprocessor. There
are several important considerations for SP.

- The ZigBee parent (coordinator or router) can buffer a message for only 30 seconds,so SP must be set to no
more than 28 seconds.

- While SP is measured in 0.01 second intervals, it only has a 0.25 second resolution, and any value sent to
the XBee RF module is rounded automatically.

- The overhead of polling for a message was tested internally and was found to be approximately 20 ms. Thus
a hypothetical sleep with SN =100 and SP = 100 will not wake the Rabbit microprocessor until 102 seconds
have elapsed (rather than the expected 100 seconds). The polling time may be sensitive to network condi-
tions and firmware version, so you should perform your own testing if timing is critical.

= SN determines how many multiples of SP the radio will sleep before waking up if no message
was otherwise received.
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Two additional parameters are described below for completeness.

= WH determines how long the XBee RF module will hold a message for the RCM4510W to
receive. Like ST, this parameter must be set carefully to ensure no messages are lost at startup.
It is currently set to 3 seconds.

= SO s a conditional flag and determines whether the XBee RF module will wake the Rabbit
4000 microprocessor if SN and SP expire, or whether both parameters are reset to resume the
sleep mode immediately.

There are several important ramifications and interactions with the operation of other function
calls to consider when using the sleep mode.

= When the Rabbit 4000 microprocessor wakes up from sleep, both the RCM4510W and user
application will fully restart. The user program will not resume from the point at which it went
to sleep.

= User data should be initialized prior to calling xbee_init() to ensure that cluster functions
or the default message handler process an incoming wake message correctly.

= When sleep is initiated, both the XBee RF module and the Rabbit 4000 microprocessor will
remain awake for the time in ST before actually powering down the Rabbit 4000 microproces-
sor and entering a low-power mode. Any messages received during this time period will cause
the counter to reset, and must be processed immediately or be lost.

= An end device is always preparing to sleep. Use xb_stayawake() to set ST to its maximum
value and periodically send data to the XBee RF module to keep it awake. Blocking for long
periods of time and failing to call xb_tick() for more than 30 seoconds could result in the
RCM4510W going to sleep unexpectedly.

The SLEEPMODE . C and SLEEPMODE2 . C sample programs in the Dynamic C SAMPLES\
RCM4500W\XBEE folder and the function documentation for zb_Rabbit_poweroff() and xb_
sleep() provide more specific information regarding the implementation and use of the sleep
mode.
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6.4 Dynamic C Function Calls

Function calls for use with the XBee RF modules are in the Dynamic C L1B\Rabbi t4000\XBee\
XBEE_AP1 .LIB library. These ZigBee specific function calls are described in An Introduction to
ZigBee, which is included in the online documentation set.

6.5 Where Do | Go From Here?

NOTE: If you purchased your RCM4510W through a distributor or through a Rabbit partner, con-
tact the distributor or partner first for technical support.

If there are any problems at this point:
= Use the Dynamic C Help menu to get further assistance with Dynamic C.

= Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/ and at
www.rabbitcom/forums/.

= Use the Technical Support e-mail form at www.rabbit.com/support/.
If the sample programs ran fine, you are now ready to go on.

An Introduction to ZigBee provides background information on the ZigBee protocol, and is
available on the CD and on our \Web site.

Digi’s XBee® OEM RF Modules provides complete information for the XBee RF module used on
the RCM4510W RabbitCore modules, provides background information on the ZigBee PRO proto-
col, and is available at ftpl.digi.com/support/documentation/90000976_a.pdf..
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APPENDIX A. RCM4510W SPECIFICATIONS

Appendix A provides the specifications for the RCM4510W, and
describes the conformal coating.
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A.1 Electrical and Mechanical Characteristics
Figure A-1 shows the mechanical dimensions for the RCM4510W.

o 1.84 X
=2 | @ |
Inininininin ey
¢ flecccconmfi= e N
=
T Please refer to the RCM4510W
5 footprint diagram later in this
'S appendix for precise header
l locations.
. — 0O~
0.125 dia N
(32) X3 = NS
=3
-8
o
)
o
o I8
i
+
—& v i v s
A SR
F S
S
NG IS
238
[ i 1 A
e 111111111 1 AT v v g
T [ T A‘« o<
I r i
<t - -5 Vo
J1 1.84 g2 58 S8

Figure A-1. RCM4510W Dimensions

NOTE: All measurements are in inches followed by millimeters enclosed in parentheses. All
dimensions have a manufacturing tolerance of £0.01" (0.25 mm).
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It is recommended that you allow for an “exclusion zone” of 0.04" (1 mm) around the
RCM4510W in all directions when the RCM4510W is incorporated into an assembly that
includes other printed circuit boards. An “exclusion zone” of 0.08" (2 mm) is recommended
below the RCM4510W when the RCM4510W is plugged into another assembly. Figure A-2
shows this “exclusion zone.”
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Figure A-2. RCM4510W “Exclusion Zone”

NOTE: There is an antenna associated with the RCM4510W RabbitCore modules. The antenna
is on the XBee RF modules for the standard versions of the RCM4510W, and is on the printed
circuit board near the shielded modem below header J4. Do not use any RF-absorbing materials
in these vicinities in order to realize the maximum range.
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Table A-1 lists the electrical, mechanical, and environmental specifications for the RCM4510W.

Table A-1. RCM4510W Specifications

Parameter

RCM4510W

Microprocessor

Rabbit® 4000 at 29.49 MHz

Flash Memory

512K

Data SRAM

512K

Backup Battery

Connection for user-supplied backup battery
(to support RTC and data SRAM)

General Purpose 1/0

up to 49 parallel digital 1/0 lines:

* up to 40 Rabbit 4000 pins configurable with four
layers of alternate functions

* up to 9 XBee RF module pins, four of which may be
configured as analog inputs*

Additional Inputs

Startup mode (2), reset in

Additional Outputs

Status, reset out

Analog Inputs*

« A/D Converter Resolution

« A/D Conversion Time (including raw count
and Dynamic C)

4 channels single-ended
0-1.2VvDC

10 bits

40 ms

External 1/0 Bus

Can be configured for 8 data lines and
6 address lines (shared with parallel 1/0 lines), plus I/O
read/write

6 high-speed, CMOS-compatible ports:
* all 6 configurable as asynchronous (with IrDA), 4 as

Serial Ports clocked serial (SPI), and 2 as SDLC/HDLC
« 1 asynchronous clocked serial port shared with pro-
gramming port
Serial Rate Maximum asynchronous baud rate = CLK/8

Slave Interface

Slave port allows the RCM4510W to be used as an
intelligent peripheral device slaved to a master
processor

Real Time Clock

Yes

Ten 8-bit timers (6 cascadable from the first),

Timers one 10-bit timer with 2 match registers, and
one 16-bit timer with 4 outputs and 8 set/reset registers
Watchdog/Supervisor Yes
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Table A-1. RCM4510W Specifications (continued)

Parameter

RCM4510W

Pulse-Width Modulators

4 channels synchronized PWM with 10-bit counter
4 channels variable-phase or synchronized PWM
with 16-bit counter

Input Capture

2-channel input capture can be used to time input
signals from various port pins

Quadrature Decoder

2-channel quadrature decoder accepts inputs
from external incremental encoder modules

Power with ZigBee® Modem
(pins unloaded)

3.3 V.DC +5%

150 mA @ 3.3 V while transmitting/receiving
80 mA @ 3.3 V while not transmitting/receiving
<20 pA @ 3.3 V while asleep

Operating Temperature

-40°C to +85°C

Humidity 5% to 95%, noncondensing
One 2 x 7, 2 mm pitch IDC signal header
Connectors One 2 x 25, 1.27 mm pitch IDC signal header

One 2 x 5, 1.27 mm pitch IDC programming header

Board Size with XBee RF module Installed

1.84" x 2.85" x 0.54"
(47 mm x 72 mm x 14 mm)

XBee

RF Module

RF Module

Digi International XBee®

Compliance

802.15.4 standard (ZigBee compliant)

* These 1/0 pins from the XBee RF module are available on auxiliary 1/0 header J4.
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A.1.1 XBee RF Module
Table A-2 shows the XBee RF module specifications.

Table A-2. XBee RF Module Specifications

Parameter Specification
RF Module Digi International XBee®
Compliance 802.15.4 standard (ZigBee compliant)
Frequency ISM 2.4 GHz
Indoor Range 100 ft (30 m)
Outdoor Line-of-Sight 300 ft (90 m)
Range
Performance Transmit Power Output 1 mwW (0 dBm)
RF Data Rate 250,000 bps
Receiver Sensitivity -92 dBm (1% PER)
Antenna Chip antenna

* Point-to-point

. * Point-to-multipoint
Supported Network Topologies
® Peer-to-peer

® Mesh

Number of RF Channels 16 direct-sequence channels
* PANID

Filtration Options * Channel

® Source/destination addresses

Transmit 40 mA @ 3.3V DC 5%

Power (typical)

Idle/Receive 40 mA @ 3.3V DC +5%

The XBee RF module that consists of discrete components on the preview versions of the
RCM4510W module has the same specifications.
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A.1.2 Headers

The RCM4510W uses a header at J1 for physical connection to other boards. J1isa 2 x 25 SMT
header with a 1.27 mm pin spacing. J2, the programming port, is a 2 x 5 header with a 1.27 mm
pin spacing. Header J4 supplies auxiliary 1/0 supported by the XBee RF module, andisa 2 x 7

SMT header with a 2 mm pin spacing

Figure A-3 shows the layout of another board for the RCM4510W to be plugged into. These ref-

erence design values are relative to one of the mounting holes.
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Figure A-3. User Board Footprint for RCM4510W
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A.2 Rabbit 4000 DC Characteristics

Table A-3. Rabbit 4000 Absolute Maximum Ratings

Symbol Parameter Maximum Rating
Ta Operating Temperature -40° to +85°C
Tg Storage Temperature -55°to +125°C

VDD, + 0.3V
\% Maximum Input Voltage 10
IH P g (max. 3.6 V)
VDD, | Maximum Operating Voltage 3.6V

Stresses beyond those listed in Table A-3 may cause permanent damage. The ratings are stress
ratings only, and functional operation of the Rabbit 4000 chip at these or any other conditions
beyond those indicated in this section is not implied. Exposure to the absolute maximum rating
conditions for extended periods may affect the reliability of the Rabbit 4000 chip.

Table A-4 outlines the DC characteristics for the Rabbit 4000 at 3.3 V over the recommended
operating temperature range from T, = -40°C to +85°C, VDD,; =3.0 V10 3.6 V.

Table A-4. 3.3 Volt DC Characteristics

Symbol Parameter Min Typ Max
VDD 1/0 Ring Supply Voltage, 3.3V 3.0V 3.3V 3.6V
10
1/0 Ring Supply Voltage, 1.8 V 165V 1.8V 190V
High-Level Input Voltage
ViH | (vDD,p =33 V) 20V
Low-Level Input Voltage
ViL | (/DD,g =33 V) 0.8V
High-Level Output Voltage
VoH | (vDD,p =33 V) 24V
Low-Level Output Voltage
VoL | (vDD,g=33V) 04V
1/0 Ring Current @ 29.4912 MHz,
|
10 33V, 25°C 12.2 mA
| All other I/O 8 mA
DRIVE | (except TXD+, TXDD+, TXD-, TXDD-)

User’s Manual 72



A.3 1/0O Buffer Sourcing and Sinking Limit

Unless otherwise specified, the Rabbit 1/O buffers are capable of sourcing and sinking 8 mA of
current per pin at full AC switching speed. Full AC switching assumes a 29.4 MHz CPU clock
with the clock doubler enabled and capacitive loading on address and data lines of less than 70 pF

per pin. The absolute maximum operating voltage on all 1/0 is 3.6 V.

A.4 Bus Loading

You must pay careful attention to bus loading when designing an interface to the RCM4510W.

This section provides bus loading information for external devices.

Table A-5 lists the capacitance for the various RCM4510W 1/O ports.

Table A-5. Capacitance of Rabbit 4000 I/O Ports

Input Output
I/0 Ports Capacitance Capacitance
(PF) (PF)
Parallel Ports Ato E 12 14

Table A-6 lists the external capacitive bus loading for the various RCM4510W output ports. Be
sure to add the loads for the devices you are using in your custom system and verify that they do

not exceed the values in Table A-6.

Table A-6. External Capacitive Bus Loading -40°C to +85°C

Output Port Clock Speed Maximum External
i (MHz) Capacitive Loading (pF)
All 1/0 lines with clock
doubler enabled 29.49 100
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Figure A-4 shows a typical timing diagram for the Rabbit 4000 microprocessor external 1/0O read
and write cycles.

External I/O Read (no extra wait states)

Tt ——f—Tw——f—— 12—

CLK —
A[15:0] — X i NC
< Tadr
/CSx | |, .
I Tcsx Tesx| <7
/I0OCSx K -
1 Tiocsx Tiocsx|< ]
/IORD -
<>TiorD TiorRD[< ]
/BUFEN -
“ITBUFEN TBUFﬁN‘_’
setup, ]
D[7:0] < VAT
| Thold "

External I/O Write (no extra wait states)

1 | Tw——r] 72—

o | | |
A[15:0] < valid : YC
N Tadr }
ICSx | 1 \ N
1 Tcsx } Tesx[<
/10CSx ! )&
«—> T f T
I0CSx | Tlocsx
/IOWR ‘
Tiowr TIOWR%
/BUFEN 8
TBUFEN TBUFEN
D[7:0] valid —
~—Tppzv | TovHzZI<—

Figure A-4. External I/O Read and Write Cycles—No Extra Wait States

NOTE: /IOCSx can be programmed to be active low (default) or active high.
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Table A-7 lists the delays in gross memory access time for several values of VDD)q.

Table A-7. Preliminary Data and Clock Delays

Clock to Address Worst-Case
VDD Output Delay Data Setup Spectrum Spreader Delay
(V)IO (ns) Time Delay (e
(ns) 0.5 ns setting| 1 ns setting | 2 ns setting
30pF | 60 pF | 90 pF no dbl /dbl | nodbl/dbl | nodbl/dbl
3.3 6 8 11 1 23/23 3/45 45/9
1.8 18 24 33 3 7/6.5 8/12 11/22

The measurements are taken at the 50% points under the following conditions.
e T=-40°Ct085°C, V =VDD,g £10%
= Internal clock to nonloaded CLK pin delay <1 ns @ 85°C/3.0 V

The clock to address output delays are similar, and apply to the following delays.

T,ar the clock to address delay

Tcsy the clock to memory chip select delay

Tiocsx: the clock to 1/0 chip select delay

Tiorp the clock to I/0 read strobe delay

Tiowr, the clock to 1/O write strobe delay
= Tguren: the clock to 1/0 buffer enable delay
The data setup time delays are similar for both Tget,, and Tpyg.

When the spectrum spreader is enabled with the clock doubler, every other clock cycle is short-
ened (sometimes lengthened) by a maximum amount given in the table above. The shortening
takes place by shortening the high part of the clock. If the doubler is not enabled, then every clock
is shortened during the low part of the clock period. The maximum shortening for a pair of clocks
combined is shown in the table.

Technical Note TN227, Interfacing External 1/0 with Rabbit Microprocessor Designs, contains
suggestions for interfacing 1/0 devices to the Rabbit 4000 microprocessors.
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A.5 Conformal Coating

The areas around the 32 kHz real-time clock crystal oscillator have had the Dow Corning sili-
cone-based 1-2620 conformal coating applied. The conformally coated area is shown in
Figure A-5. The conformal coating protects these high-impedance circuits from the effects of
moisture and contaminants over time.

Conformally coated
area

e
P4
e
4
P4
ol or

XNV

Figure A-5. RCM4510W Areas Receiving Conformal Coating

Any components in the conformally coated area may be replaced using standard soldering proce-
dures for surface-mounted components. A new conformal coating should then be applied to offer
continuing protection against the effects of moisture and contaminants.

NOTE: For more information on conformal coatings, refer to Rabbit’s Technical Note TN303,
Conformal Coatings, which is included with the online documentation.
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A.6 Jumper Configurations

Figure A-6 shows the header locations used to configure the various RCM4510W options via
jumpers.

RCM4510W

0000000000

Q| &
é’%
g s

O

w_w_r_%'ur_w_
TSRS T
EEEEEEEEERER

xStream

Figure A-6. Location of RCM4510W Configurable Positions

Table A-8 lists the configuration options.

Table A-8. RCM4510W Jumper Configurations

Header Description Pins Connected il
Default
1-2 |PE5 X
PE5 or SMODEOQ Output
JP1 ;
on J1 pin 37
2-3 | SMODEO
1-2 | PE6 X
PE6 or SMODE1 Output
JP2 ]
on J1 pin 38
2-3 |SMODE1
1-2 |PE7 X
PE7 or STATUS Output
JP3 ;
on J1 pin 39
2-3 |STATUS
1-2 |LNO
JP4 | LNO or PDO on J1 pin 40
2-3 | PDO X
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Table A-8. RCM4510W Jumper Configurations (continued)

Header Description Pins Connected Factory
Default

1-2 |LN2

JP5 LN2 or PD2 on J1 pin 42
2-3 |PD2 X
1-2 |LN4

JP6 LN4 or PD4 on J1 pin 44
2-3 | PD4 X
1-2 |LN6

JP7 LNG6 or PD6 on J1 pin 46
2-3 |PD6 X
1-2 |LN7

JP8 LN7 or PD7 on J1 pin 47
2-3 |PD7 X
1-2 |LN5

JP9 LN5 or PD5 on J1 pin 45
2-3 | PD5 X
1-2 |LN3

JP10 |LN3or PD3onJlpin43
2-3 |PD3 X
1-2 |LN1

JP11 |LN1orPD1onJ2pin4l
2-3 |PD1 X

NOTE: The jumper connections are made using 0 Q surface-mounted resistors.
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APPENDIX B. PROTOTYPING BOARD

Appendix B describes the features and accessories of the Prototyping
Board, and explains the use of the Prototyping Board to demonstrate
the RCM4510W and to build prototypes of your own circuits. The
Prototyping Board has power-supply connections and also provides
some basic 1/0O peripherals (RS-232, LEDs, and switches), as well as a
prototyping area for more advanced hardware development.
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B.1 Introduction

The Prototyping Board included in the Development Kit makes it easy to connect an RCM4510W
module to a power supply and a PC workstation for development. It also provides some basic 1/O
peripherals (RS-232, LEDs, and switches), as well as a prototyping area for more advanced hard-
ware development.

For the most basic level of evaluation and development, the Prototyping Board can be used with-
out modification.

As you progress to more sophisticated experimentation and hardware development, modifications
and additions can be made to the board without modifying the RCM4510W module.

The Prototyping Board is shown below in Figure B-1, with its main features identified.

Current-
Measurement
Headers
Power Backup +5V,3.3V,and
Input Battery GND Buses
Power Reset
LED \ Switch
RCM4510W »
Module \
Connector
RS-232
Header
“Through-Hole 3
RCM4510W - Prototyping Area ;:
= 00000000000000 SMT Prototyping
Standoff - 00300000000000 |11 Area
Mounting ~eer 9833098335
o pes) g 000
(e]@]
Analog User
I/0 LEDs

; RCM4510W
SMT F/’Ar?etgtyplng Module User
Extension Header Switches

Figure B-1. Prototyping Board
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B.1.1 Prototyping Board Features

e Power Connection—A a 3-pin header is provided for connection to the power supply. Note
that the 3-pin header is symmetrical, with both outer pins connected to ground and the center
pin connected to the raw V+ input. The cable of the AC adapter provided with the North
American version of the Development Kit is terminated with a header plug that connects to the
3-pin header in either orientation. The header plug leading to bare leads provided for overseas
customers can be connected to the 3-pin header in either orientation.

Users providing their own power supply should ensure that it delivers 8-24 V DC at 8 W. The
voltage regulators will get warm while in use.

e Regulated Power Supply—The raw DC voltage provided at the 3-pin header is routed to a 5
V switching voltage regulator, then to a separate 3.3 V linear regulator. The regulators provide
stable power to the RCM4510W module and the Prototyping Board.

= Power LED—The power LED lights whenever power is connected to the Prototyping Board.

= Reset Switch—A momentary-contact, normally open switch is connected directly to the
RCM4510W’s /RESET _IN pin. Pressing the switch forces a hardware reset of the system.

= |/O Switches and LEDs—Two momentary-contact, normally open switches are connected to
the PB4 and PB5 pins of the RCM4510W module and may be read as inputs by sample appli-
cations.

Two LEDs are connected to the PB2 and PB3 pins of the RCM4510W module, and may be
driven as output indicators by sample applications.

= Prototyping Area—A generous prototyping area has been provided for the installation of
through-hole components. +3.3 V, +5 V, and Ground buses run around the edge of this area.
Several areas for surface-mount devices are also available. (Note that there are SMT device
pads on both top and bottom of the Prototyping Board.) Each SMT pad is connected to a hole
designed to accept a 30 AWG solid wire.

= Module Extension Header—The complete pin set of the RCM4510W module is duplicated
at header J2. Developers can solder wires directly into the appropriate holes, or, for more flex-
ible development, a 2 x 25 header strip with a 0.1" pitch can be soldered into place. See
Figure B-4 for the header pinouts.

NOTE: The same Prototyping Board can be used for several series of RabbitCore modules, and so
the signals at J2 depend on the signals available on the specific RabbitCore module.
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= Analog Inputs Header—The analog signals from the RabbitCore module are presented at
header J3 on the Prototyping Board. These analog signals are connected via attenuator/filter
circuits on the Prototyping Board to the corresponding analog inputs on the RCM4510W mod-
ule.

NOTE: No analog signals are available on the Prototyping Board with the RCM4510W Rab-
bitCore module installed since no analog signals are present on the RCM4510W’s header J1.
The auxiliary 1/0 on the RCM4510W'’s header J4 cannot be used with the Prototyping Board
without modifying the Prototyping Board.

= RS-232—Two 3-wire or one 5-wire RS-232 serial ports are available on the Prototyping
Board at header J4. A 10-pin 0.1" pitch header strip installed at J4 allows you to connect a rib-
bon cable that leads to a standard DE-9 serial connector.

= Current Measurement Option—You may cut the trace below header JP1 on the bottom side
of the Prototyping Board and install a 1 x 2 header strip from the Development Kit to allow
you to use an ammeter across the pins to measure the current drawn from the +5 V supply.
Similarly, you may cut the trace below header JP2 on the bottom side of the Prototyping Board
and install a 1 x 2 header strip from the Development Kit to allow you to use an ammeter
across the pins to measure the current drawn from the +3.3 V supply.

= Backup Battery—A 2032 lithium-ion battery rated at 3.0 V, 220 mA-h, provides battery
backup for the RCM4510W SRAM and real-time clock.
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B.2 Mechanical Dimensions and Layout

Figure B-2 shows the mechanical dimensions and layout for the Prototyping Board.
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Figure B-2. Prototyping Board Dimensions

NOTE: All measurements are in inches followed by millimeters enclosed in parentheses. All
dimensions have a manufacturing tolerance of £0.01" (0.25 mm).
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Table B-1 lists the electrical, mechanical, and environmental specifications for the Prototyping
Board.

Table B-1. Prototyping Board Specifications

Parameter Specification
Board Size 3.80" x 3.80" x 0.48" (97 mm x 97 mm x 12 mm)
Operating Temperature 0°Cto +70°C
Humidity 5% to 95%, noncondensing
Input Voltage 8Vto24VDC
Maximum Current Draw 800 mA max. for +3.3 V supply,

(including user-added circuits) | 1 A total +3.3 V and +5 V combined

1.3" x 2.0" (33 mm x 50 mm) throughhole, 0.1" spacing,

Prototyping Area additional space for SMT components

One 2 x 25 header socket, 1.27 mm pitch, to accept RCM4510W
One 1 x 3 IDC header for power-supply connection

One 2 x 5 IDC RS-232 header, 0.1" pitch

Two unstuffed header locations for analog and RCM4510W
signals

25 unstuffed 2-pin header locations for optional configurations

Connectors

B.3 Power Supply

The RCM4510W requires a regulated 3.0 V — 3.6 VV DC power source to operate. Depending on
the amount of current required by the application, different regulators can be used to supply this
voltage.

The Prototyping Board has an onboard +5 V switching power regulator from which a +3.3 V lin-
ear regulator draws its supply. Thus both +5 V and +3.3 V are available on the Prototyping Board.

The Prototyping Board itself is protected against reverse polarity by a Shottky diode at D2 as
shown in Figure B-3.

LINEAR POWER
REGULATOR +33V
SWITCHING POWER REGULATOR +5V

J1
o 1 LM1117 Jp2
W, k] 0 , DCIN = i Ul e
- Ll
Q B DL4003 lcs l c6 c4 1 c2
:[47 uF 330 uH 1330 uF 10 pF:l: T I‘IO uF
= 1 LM2575 L = 1 1 = L
- i 1 X - - -
AL + 4 B140

Figure B-3. Prototyping Board Power Supply
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B.4 Using the Prototyping Board

The Prototyping Board is actually both a demonstration board and a prototyping board. As a dem-
onstration board, it can be used to demonstrate the functionality of the RCM4510W right out of
the box without any modifications to either board.

The Prototyping Board comes with the basic components necessary to demonstrate the operation
of the RCM4510W. Two LEDs (DS2 and DS3) are connected to PB2 and PB3, and two switches
(S2 and S3) are connected to PB4 and PB5 to demonstrate the interface to the Rabbit 4000 micro-
processor. Reset switch S1 is the hardware reset for the RCM4510W.

The Prototyping Board provides the user with RCM4510W connection points brought out conve-
niently to labeled points at header J2 on the Prototyping Board. Although header J2 is unstuffed, a
2 x 25 header is included in the bag of parts. RS-232 signals (Serial Ports C and D) are available
on header J4. A header strip at J4 allows you to connect a ribbon cable, and a ribbon cable to DB9
connector is included with the Development Kit. The pinouts for these locations are shown in
Figure B-4.

GND

GND

J2

+3.3V Q| 6nD
/RsT_ouT |O Q| 10rRD

RCM4500W
Signals

VREF [Q Q| AGND

o
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=
5
9]
Q
)
<
3

Ol VREF

AGND

J4

TxD
RxD
GND

RxC
TxC

RS-232

AGND
LNOIN |OQ

OQ
o]
cvT[OQ| LN7IN
LN6IN JOO| LN5IN
LN4IN [O O LN3IN
LN2IN [OO| LN1IN
S

Analog
Inputs

Figure B-4. Prototyping Board Pinout

Although analog signals are shown for labeled points at header location J3 on the Prototyping
Board, the analog signals on the RCM4510W are associated with the XBee RF module. These
analog signals are not brought out to the Prototyping Board.
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All signals from the RCM4510W module are available on header J2 of the Prototyping Board.
The remaining ports on the Rabbit 4000 microprocessor are used for RS-232 serial communica-
tion. Table B-2 lists the signals on header J2 and, where applicable, explains how they are config-
ured by the brdinit() function call for use on the Prototyping Board.

Table B-2. Use of RCM4510W Signals on the Prototyping Board

Pin Pin Name Prototyping Board Use
1 +3.3V | +3.3V power supply
2 GND
3 /RST_OUT | Reset output from reset generator
4 /IORD External read strobe
5 /IOWR External write strobe
6 /RESET _IN | Input to reset generator
7 VBAT_EXT | External backup battery connection
8-15 PAO-PA7 | Output, high
16 PBO Output, high
17 PB1 Programming port CLKA
18 PB2 LED DS2 (normally high/off)
19 PB3 LED DS3 (normally high/off)
20 PB4 Switch S2 (normally open/pulled up)
21 PB5 Switch S3 (normally open/pulled up)
22-23 PB6-PB7 | Output, high
24-25 PCO-PC1 | Serial Port D (RS-232, header J4) (high)
26-27 PC2-PC3 | Serial Port C (RS-232, header J4) (high)
28-29 PC4-PC5 | Serial Port B (used by XBee RF module)
30-31 PC6-PC7 | Serial Port A (programming port) (high)
32-39 PEO-PE7 | Output, high
40-47 PD0O-PD7 | Output, high
48 CONVERT | Not available
49 VREF Not available
50 GND

There isa 1.3" x 2" through-hole prototyping space available on the Prototyping Board. The holes
in the prototyping area are spaced at 0.1" (2.5 mm). +3.3 V, +5 V, and GND traces run along the
top edge of the prototyping area for easy access. Small to medium circuits can be prototyped using
point-to-point wiring with 20 to 30 AWG wire between the prototyping area, the +3.3 V, +5 V, and
GND traces, and the surrounding area where surface-mount components may be installed. Small
holes are provided around the surface-mounted components that may be installed around the pro-
totyping area.
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B.4.1 Adding Other Components

There are pads for 28-pin TSSOP devices, 16-pin SOIC devices, and 6-pin SOT devices that can
be used for surface-mount prototyping with these devices. There are also pads that can be used for
SMT resistors and capacitors in an 0805 SMT package. Each component has every one of its pin
pads connected to a hole in which a 30 AWG wire can be soldered (standard wire wrap wire can
be soldered in for point-to-point wiring on the Prototyping Board). Because the traces are very
thin, carefully determine which set of holes is connected to which surface-mount pad.

B.4.2 Measuring Current Draw

The Prototyping Board has a current-measurement feature available at header locations JP1 and
JP2 for the +5 V and +3.3 V supplies respectively. To measure current, you will have to cut the
trace on the bottom side of the Prototyping Board corresponding to the power supply or power
supplies whose current draw you will be measuring. Header locations JP1 and JP2 are shown in
Figure B-5. Then install a 1 x 2 header strip from the Development Kit on the top side of the Pro-
totyping Board at the header location(s) whose trace(s) you cut. The header strip(s) will allow you
to use an ammeter across their pins to measure the current drawn from that supply. Once you are
done measuring the current, place a jumper across the header pins to resume normal operation.

Bottom Side O
JP1

©,0)
JP2 '
) Cut traces

JP2

CURRENT
MEASUREMENT
JP1 (+5 V)

ooy @O »

Figure B-5. Prototyping Board Current-Measurement Option

NOTE: Once you have cut the trace below header location JP1 or JP2, you must either be using
the ammeter or have a jumper in place in order for power to be delivered to the Prototyping
Board.

B.4.3 Analog Features

The Prototyping Board has typical support circuitry installed to complement the ADS7870 A/D
converter chip, which is available on other RabbitCore modules based on the Rabbit 4000 micro-
processor, but is not installed on the RCM4510W model. The analog inputs from the auxiliary 1/0 on
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the RCM4510W’s header J4 cannot be used with the Prototyping Board without modifying the Prototyp-
ing Board.

B.4.4 Serial Communication
The Prototyping Board allows you to access the serial ports from the RCM4510W module.
Table B-3 summarizes the configuration options.

Table B-3. Prototyping Board Serial Port Configurations

Serial Port Header Default Use Alternate Use
A J2 Programming Port RS-232
B J2 XBee RF Module RS-232
C J2,04 RS-232 —
D J2,04 RS-232 —
E J2 — —
F J2 — —

Serial Ports E and F may be used as serial ports, or the corresponding pins at header location J2
may be used as parallel ports.

B.4.4.1 RS-232

RS-232 serial communication on header J4 on both Prototyping Boards is supported by an
RS-232 transceiver installed at U3. This transceiver provides the voltage output, slew rate, and
input voltage immunity required to meet the RS-232 serial communication protocol. Basically,
the chip translates the Rabbit 4000’s signals to RS-232 signal levels. Note that the polarity is
reversed in an RS-232 circuit so that a +3.3 V output becomes approximately -10 V and 0 V is
output as +10 V. The RS-232 transceiver also provides the proper line loading for reliable com-
munication.

RS-232 can be used effectively at the RCM4510W module’s maximum baud rate for distances of
up to 15 m.
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RS-232 flow control on an RS-232 port is initiated in software using the serXflowcontrolOn
function call from RS232. L 1B, where X is the serial port (C or D). The locations of the flow con-
trol lines are specified using a set of five macros.

SERX_RTS_ PORT—Data register for the parallel port that the RTS line is on (e.g., PCDR).
SERA_RTS_ SHADOW—Shadow register for the RTS line's parallel port (e.g., PCDRShadow).
SERA_RTS_BIT—The bit number for the RTS line.

SERA _CTS_PORT—Data register for the parallel port that the CTS line is on (e.g., PCDRShadow).
SERA_CTS_BIT—The bit number for the CTS line.

Standard 3-wire RS-232 communication using Serial Ports C and D is illustrated in the following
sample code.

#define CINBUFSIZE 15 // set size of circular buffers in bytes
#define COUTBUFSIZE 15

#define DINBUFSIZE 15
#define DOUTBUFSIZE 15

#define MYBAUD 115200 // set baud rate
#endi

main(Q{
serCopen(_MYBAUD) ; // open Serial Ports C and D

serDopen(_MYBAUD) ;

serCwrFlush(Q); // flush their input and transmit buffers
serCrdFlush();

serDwrFlush(Q);

serDrdFlush();

serCclose(_MYBAUD); // close Serial Ports C and D
serDclose(_MYBAUD) ;
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B.5 Prototyping Board Jumper Configurations

Figure B-6 shows the header locations used to configure the various Prototyping Board options

via jumpers.
JP1
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Figure B-6. Location of Configurable Jumpers on Prototyping Board

Table B-4 lists the configuration options using either jJumpers or 0 Q surface-mount resistors.

Table B-4. RCM4510W Prototyping Board Jumper Configurations

Header Description Pins Connected Factory
Default
JP1 +5 V Current Measurement 1-2 | Via trace or jumper Connected
JP2 | +3.3V Current Measurement | 1-2 | Via trace or jumper Connected
Jllig TxD on header J4 X
IP3 PCO/TxD/LED DS2 JP4
JP4 1-2 PCO to LED DS2
n.c. | PCO available on header J2
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Table B-4. RCM4510W Prototyping Board Jumper Configurations (continued)

Header Description Pins Connected Factory
Default
‘ilig RxD on header J4 X
IS pc1/RxDISWitch S2 IP6
JP6 1-2 PC1 to Switch S2
n.c. | PC1 available on header J2
‘iz TxC on header J4 X
T pcorTxCILED DS3 IP6
JP8 1-2 PC2 to LED DS3
n.c. | PC2 available on header J2
P9 PC3 to Switch S3
1-2
PO | bea/Rxc/switch S3 IP10
JP10 12 RxC on header J4 X
n.c. | PC3 available on header J2
LNO buffer/filter to
JP11 RCMA510W 1-2 Connected
1-2 | Connected: PB2 to LED DS2 X
JP12 | PB2/LED DS2
n.c. | PB2 available on header J2
LN1 buffer/filter to
JP13 RCMA510W 1-2 Connected
1-2 | Connected: PB3 to LED DS3 X
JP14 PB3/LED DS3
n.c. | PB3 available on header J2
LN2 buffer/filter to
JP15 RCMA510W 1-2 Connected
1-2 | Connected: PB4 to Switch S2 X
JP16 | PB4/Switch S2
n.c. | PB4 available on header J2
LN3 buffer/filter to
JP17 RCMA510W 1-2 Connected
1-2 | Connected: PB5 to Switch S3 X
JP18 | PB5/Switch S3
n.c. | PB5 available on header J2
LN4 buffer/filter to
JP19 RCMA510W 1-2 Connected
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Table B-4. RCM4510W Prototyping Board Jumper Configurations (continued)

Header Description Pins Connected Factory
Default
LN5 buffer/filter to
JP20 RCMA510W 1-2 Connected
LNG6 buffer/filter to
JP21 RCMA510W 1-2 Connected
LN7 buffer/filter to
JP22 RCMA510W 1-2 Connected
1-2 | Tied to analog ground X
JP23 | LN4_IN-LN6_IN
2-3 | Tied to VREF
1-2 | Tied to analog ground X
JP24 | LNO_IN-LN3_IN
2-3 | Tied to VREF
JP25 | Thermistor Location 1-2 n.c.

NOTE: Jumper connections JP3-JP10, JP12, JP14, JP16, JP18, JP23, and JP24 are made using O
Q surface-mounted resistors. Jumper connections JP11, JP13, JP15, JP17, and JP19-JP22 are
made using 470 Q surface-mounted resistors.
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APPENDIX C. POWER SUPPLY

Appendix C provides information on the current requirements of the
RCM4510W, and includes some background on the chip select circuit
used in power management.

C.1 Power Supplies

The RCM4510W requires a regulated 3.3 VV DC +5% power source. The RabbitCore design pre-
sumes that the voltage regulator is on the user board, and that the power is made available to the
RCM4510W board through header J1.

An RCM4510W with no loading at the outputs operating at 29.48 MHz typically draws 80 mA,
and may draw up to 150 mA while the XBee RF module is transmitting or receiving.

C.1.1 Battery Backup

The RCM4510W does not have a battery, but there is provision for a customer-supplied battery to
back up the data SRAM and keep the internal Rabbit 4000 real-time clock running.

Header J1, shown in Figure C-1, allows access to the external battery. This header makes it possi-
ble to connect an external 3 V power supply. This allows the SRAM and the internal Rabbit 4000
real-time clock to retain data with the RCM4510W powered down.

J1

Ext | +3.3V_IN 1 o ol GND
xternal ———
Battery

\.I VBAT_EXT 7 8

— o o

Figure C-1. External Battery Connections
at Header J1

A lithium battery with a nominal voltage of 3 V and a minimum capacity of 165 mA-h is recom-
mended. A lithium battery is strongly recommended because of its nearly constant nominal volt-
age over most of its life.
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The drain on the battery by the RCM4510W is typically 7.5 pA when no other power is supplied.
If a 165 mA-h battery is used, the battery can last about 2.5 years:

165 mA:-h

75 A = 2.5 years.

The actual battery life in your application will depend on the current drawn by components not on
the RCM4510W and on the storage capacity of the battery. The RCM4510W does not drain the bat-
tery while it is powered up normally.

Cycle the main power off/on after you install a backup battery for the first time, and whenever
you replace the battery. This step will minimize the current drawn by the real-time clock oscilla-
tor circuit from the backup battery should the RCM4510W experience a loss of main power.

NOTE: Remember to cycle the main power off/on any time the RCM4510W is removed from the
Prototyping Board or motherboard since that is where the backup battery would be located.

Rabbit’s Technical Note TN235, External 32.768 kHz Oscillator Circuits, provides additional
information about the current draw by the real-time clock oscillator circuit.

C.1.2 Battery-Backup Circuit
Figure C-2 shows the battery-backup circuit.

VRAM VOSC

External Battery D4 R15

VBAT-EXT
100 kQ

C45

:|:10nF

Figure C-2. RCM4510W Backup Battery Circuit

The battery-backup circuit serves three purposes:

= [t reduces the battery voltage to the SRAM and to the real-time clock, thereby limiting the cur-
rent consumed by the real-time clock and lengthening the battery life.

= [t ensures that current can flow only out of the battery to prevent charging the battery.

= Avoltage, VOSC, is supplied to U11, which keeps the 32.768 kHz oscillator working when
the voltage begins to drop.

C.1.3 Reset Generator

The RCM4510W uses a reset generator to reset the Rabbit 4000 microprocessor when the voltage
drops below the voltage necessary for reliable operation. The reset occurs between 2.85 V and 3.00
V, typically 2.93 V. Since the RCM4510W will operate at voltages as low as 3.0 V, exercise care
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when operating close to the 3.0 VV minimum voltage (for example, keep the power supply as close as
possible to the RCM4510W) since your RCM4510W could reset unintentionally.

The RCM4510W has a reset output, pin 3 on header J1.
C.1.4 XBee RF Module Power Supply

The XBee RF module is isolated from digital noise generated by other components by way of a low-
pass filter composed of L5 and C90 on the RCM4510W as shown in Figure C-3. The filtered power
supply powers the XBee RF module, and is available via pin 8 of auxiliary 1/0 header J4 on the
RCM4510W module. If you draw on this filtered power supply, the maximum current draw is 25
mA.

+3.3V

L5

YY1 Filtered +3.3 V Supply
to ZigBee Modem

C90

10pF:|:

Figure C-3. XBee RF Module Supply Circuit

C.2 Powerdown Mode

The XBee RF module can power down the remaining RCM4510W circuitry via the
zb_Rabbit_poweroff() or the xb_sleep() Dynamic C function calls. The real-time clock
and the data SRAM will still be powered during the powerdown from the +3.3 VV DC supplied to
the RCM4510W module via header J1 as long as that voltage exceeds the voltage of the backup
battery.
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APPENDIX D. ADDITIONAL CONFIGURATION
INSTRUCTIONS

Appendix D provides information on how to find the latest firmware

for the XBee RF module and the Digi® XBee USB used as the ZigBee
coordinator, and how to install the firmware.

D.1 XBee RF Module Firmware Downloads

By default, the RCM4510W is shipped from the factory with firmware to operate as either a router or
as an end device in a mesh network. You will need to run the MODEMFWLOAD . C sample program in
the Dynamic C SAMPLES\RCM4500W\XBee folder to download the firmware needed to operate the
RCM4510W as a coordinator.

NOTE: You can verify the firmware version by running the AT_INTERACTIVE . C sample
program in the Dynamic C SAMPLES\XBEE folder and by entering the command ATVR
<Enter> to get the version number displayed in the Dynamic C STDIO window.

CAUTION: Different firmware versions are likely to interact with the Dynamic C libraries in
different ways. Rabbit has tested the firmware associated with a particular version of Dynamic
C for correct operation, and only this version is included on the Dynamic C CD-ROM — do not
use any other firmware versions with that version of Dynamic C.

Once you have successfully loaded the firmware, compile and run another sample program to
make sure the MODEMFWLOAD . C sample program does not inadvertently reload (or partially
reload) the firmware.

If you are uploading firmware because you upgraded to a more recent Dynamic C release,
remember to recompile your applications using the new version of Dynamic C once you have
uploaded the new firmware.

D.1.1 Dynamic Cv. 10.44 and Later

Encrypted libraries have been created within Dynamic C for the firmware. The three ZigBee PRO
libraries are in the LIB\Rabbit4000\XBee\XBee_Firmware\ZigBee folder.

e A Dynamic C library of the type XB24-zZB_21....LIB is used for a coordinator RCM4510W.
= A Dynamic C library of the type XB24-zB_23...LIB is used for a router RCM4510W.
= A Dynamic C library of the type XB24-zZB_29....LIB is used for an end-device RCM4510W.
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There are also two ZNet 2.5 libraries in the LIB\Rabbit4000\XBee\XBee Firmware\ZNet
folder.

= A Dynamic C library of the type XB24-B_ZigBee_..41.LIB is used for a coordinator
RCM4510W.

= A Dynamic C library of the type XB24-B_ZigBee_..47 .LIB is used for an end-device/router
RCM4510W.

Make the following modifications to the MODEMFWLOAD . C sample program.before you run it
according to whether you will be using the RCM4510W as a coordinator, a router, or an end
device.

= Select the XBee role macro according to whether the RCM4510W is being used as a coordina-
tor, a router or an end device.
#define XBEE_ROLE NODE_TYPE_COORD
#define XBEE_ROLE NODE_TYPE_ROUTER
#define XBEE_ROLE NODE_TYPE_ENDDEV

= The RCM4510W uses either the ZNet 2.5 protocol or the ZB protocol. Make sure the
#define statement calls for the protocol used.
#define XBEE_PROTOCOL XBEE_PROTOCOL_ZNET
#define XBEE_PROTOCOL XBEE_PROTOCOL_ZB

D.1.2 Dynamic Cv. 10.21 (RCM4510W preview and standard versions)

Encrypted libraries have been created within Dynamic C for the two types of firmware. The two
libraries provided are in the LIB\Rabbi t4000\RCM4xxx\RCM45xxW_XBee_Ffirmware folder.

= A Dynamic C library of the type XB24-B_ZigBee_11...LIB is used for a coordinator
RCM4510W.

= A Dynamic C library of the type XB24-B_ZigBee_13...LIB is used for an end device/router
RCM4510W.

Make the following modifications to the MODEMFWLOAD . C sample program.before you run it
according to whether you will be using the RCM4510W as a coordinator, a router, or an end
device.

= Uncomment the following line if you will be using the RCM4510W as a coordinator.

#define ZIGBEE_COORDINATOR

= Uncomment either of the following two lines if you will be using the RCM4510W as a router
or an end device. The same firmware will be uploaded to the RCM4510W regardless of which
line is commented out.

#define ZIGBEE_ROUTER
#define ZIGBEE_ENDDEV
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D.1.3 Dynamic Cv. 10.11 (RCM4510W preview version only)

The coordinator and end-device/router firmware is provided in the Dynamic C SAMPLES\
RCM4500W\MODEMFW folder.

= Firmware of the type XB24-B_ZigBee_11...ebl is used for a coordinator RCM4510W.

= Firmware of the type XB24-B_ZigBee_13...ebl is used for an end device/router
RCM4510W.

When you use the bootloader function, you will have to provide a file read function that supplies
the binary image in record sizes specified by the xmodem protocol. The read function will have
the following prototype.

char *fileread(int recordNumber, int recordSize)

The function will return the address of a buffer containing the data. A NULL return signifies the
end of the file.

Before you compile and run this sample program, modify the ximport statement to point to the
binary image file you will be downloading.

#ximport "MODEMFW/Coordinator/XB24-B ZigBee 1118_ebl™ zb_ebl_file

In this example, the XB24-B_ZigBee_1118.ebl file is in the Dynamic C SAMPLES\
RCM4500W\MODEMFW\Coordinator folder. If you downloaded a firmware update to another
location on your hard drive, you would change the directory path accordingly as in the following
example.

#ximport "/temp/XB24-B_ZigBee 1118.ebl' zb_ebl_file

To see the details of what is happening while the sample program runs, you should #define the
following.

#define ZB_VERBOSE
#define XMODEM_DEBUG
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D.2 Digi® XBee USB Configuration

You may experience difficulty when you use the ZigBee sample programs and the Digi® XBee
USB with the default settings if you are working simultaneously with more than one ZigBee
coordinator.

Section 6.2.2 explains how to set up the RCM4510W configuration patterns for the sample pro-
grams via macros in the Dynamic C LIB\Rabbit4000\XBee\XBEE_API .LIB library folder.

ZB ZNet 2.5

Extended PAN ID — the 64-bit network ID. | PAN ID — the network 1D. Defaults to
Defaults to DEFAULT_PANID if setin the | 0x0234 via the macro in the Dynamic C
Dynamic C L1B\Rabbit4000\XBee\ LIB\Rabbit4000\XBee\XBEE_API .LIB
XBEE_AP1 . LIB library, otherwise defaults | library. Change the PAN ID if you are

to 0x0123456789abcdef to match the developing simultaneously with more than
default used on the Digi® XBee USB. one ZigBee coordinator.

If set to 0x00, tells coordinators to “selecta | #define DEFAULT_PANID 0x0234
random extended PAN ID,” and tells routers
and end devices to “join any network.”

Change the extended PAN ID if you are
developing simultaneously with more than
one ZigBee coordinator.

#define DEFAULT_EXTPANID
"'0x0123456789abcdef""

Channel mask — defaults to Ox1FFE, i.e., all 12 possible channels via the macro in the
Dynamic C L1B\Rabbit4000\ZigBee\XBEE_API .LIB library.

#define DEFAULT_CHANNELS ZB_DEFAULT_CHANNELS
For example, to limit the channels to three channels, the macro would read as follows.

#define DEFAULT_CHANNELS OxOO0OE

The same configurations must then be applied to the Digi® XBee USB via Digi’s X-CTU utility.
If you have not previously used this utility, install it from the Dynamic C Utilities\X-CTU
folder by double-clicking Setup_XCTU_xxxx .exe (where xxxx is the version number),

Continue the following steps with the Digi® XBee USB connected to your PC’s USB port. Since
the ZigBee Utility XBEE_GP10_GUI . exe will conflict with X-CTU, first close the ZigBee Utility
if it is running.

1. Start X-CTU from the desktop icon and set the “PC Settings” tab to 115200 baud, HARD-
WARE flow control, 8 data bits, parity NONE, 1 stop bit.

2. On the “PC Settings” tab, check the “Enable API1” box under “Host Setup.”

User’s Manual 99



3. On the “PC Settings” tab, select the “USB Serial Port” corresponding to the USB serial port
the Digi® XBee USB is connected to and click “Test/Query.” You should see a response show-
ing the Modem Type (XB 24-B) and the firmware version. Click OK.

Note that several USB serial ports could be listed. If you select a serial port without the Digi®
XBee USB connected, the X-CTU response to “Test/Query.” will be “communication with
modem ... OK,” but the modem type will be unknown, and the firmware version will be blank.

If you a get a message that X-CTU is unable to open the COM port, verify that you selected the
COM port with the “USB Serial Port,” then try unplugging the Digi® XBee USB from the USB
slot and plugging it back in. Now click “Test/Query” again.

4. Under the “Modem Configuration” tab click the “Read” button. X-CTU will now display the
networking and 1/0 parameters for the Digi® XBee USB being used as the ZigBee coordinator.

Modem: XBEE XB24-ZB

Function Set: ZIGBEE COORDINATOR API (do not select other settings)

Version: the version of the firmware included with the version of Dynamic C you are using (should be of the
type 21..)

5. Now set the networking parameters in your project defines or in the sample program to match
the parameters in the Dynamic C L1B\Rabbit4000\XBee\XBEE_API .LIB library.

6. Now set the networking parameters in your project defines or in the sample program to match
the parameters in the Dynamic C L1B\Rabbit4000\XBee\XBEE_API _LIB library.
Networking

(D) CH - Operating Channel — this is the operating channel you could see when you ran the
AT_INTERACTIVE . C sample program in the Dynamic C SAMPLES\XBEE folder by entering the
command ATCH <Enter>. This channel information cannot be changed from the X-CTU utility.

(0123456789ABCDEF) ID - Extended Pan ID — set the new extended PAN ID that follows 0x to match the
DEFAULT_EXTPANID macro.

(1FFE) SC - Scan Channels - set the new value for the channels to scan, E, for example, to match the new
setting in the macro.

#define DEFAULT_CHANNELS Ox000E
7. Finish by clicking the “Write” button.

We are including a profile file (XBee-USB ZB defaults.pro)inthe Utilities/X-CTU folder
to load a Digi® XBee USB with default settings. Once the Digi® XBee USB is connected to an
available USB port on your PC, start the X-CTU utility. Click the “Load” button in the Profile
section, navigate to the . pro file, and it will set all of the defaults. Then click the “Write” button
to write the settings to the Digi® XBee USB.

D.2.1 Additional Reference Information

Check Digi’s Web site for the latest information and documentation on the XBee RF module, the
X-CTU utility, and the Digi® XBee USB. Note that the XBee® and the XBee PRO® RF modules
are presently not compatible with the XBeeRF module used with the RCM4510W, but the general
documentation about ZigBee and the use of AT commands for the XBee® and the XBee PRO® RF
modules is relevant.
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D.2.2 Update Digi® XBee USB Firmware

The firmware version used by the Digi® XBee USB must correspond to the firmware version
installed on the RCM4510W. If you have updated the RCM4510W firmware (or you have a need
to re-install the firmware on the Digi® XBee USB), the corresponding firmware for the Digi®
XBee USB is in the Dynamic C Uti I i ties\X-CTU\MODEMFW folder.

= Remember to record the extended PAN ID, NI, and other parameters you are using.

= Firmware of the type XB24-ZB_21...zip is used for the Digi® XBee USB coordinator.
CAUTION: Different firmware versions are likely to interact with the Dynamic C libraries in dif-
ferent ways. Rabbit has tested the firmware associated with a particular version of Dynamic C

for correct operation, and only this version is included on the Dynamic C CD-ROM — do not
use any other firmware versions with that version of Dynamic C.

. Start X-CTU from the desktop icon and set the “PC Settings” tab to 9600 baud, HARDWARE
flow control, 8 data bits, parity NONE, 1 stop bit.

. On the “PC Settings” tab, check the “Enable API” box under “Host Setup.”

. On the “PC Settings” tab, select the “USB Serial Port” and click “Test/Query.” You should see
a response showing the Modem Type (XB 24 B) and the firmware version. Click OK.

[EN

w N

Note that several USB serial ports could be listed. If you select a serial port without the Digi®
XBee USB connected, the X-CTU response to “Test/Query.” will be “communication with
modem ... OK,” but the modem type will be unknown, and the firmware version will be blank.

If you a get a message that X-CTU is unable to open the COM port, verify that you selected the
COM port with the “USB Serial Port,” then try unplugging the Digi® XBee USB from the USB
slot and plugging it back in. Now click “Test/Query” again.

4. Under the “Modem Configuration” tab click the “Read” button. X-CTU will now display the
networking and 1/0 parameters for the Digi® XBee USB.
Modem: XBEE XB24-ZB
Function Set: ZIGBEE COORDINATOR API (do not select other settings)
Version: the version of the firmware included with the version of Dynamic C you are using
5. Click the “Read” button, select XB24-B as the Modem type; select ZIGBEE COORDINATOR
API as the Function Set, and 21... as the Version, then click “Write.”

6. When the process is complete set the PANID, NI, and other parameters to the values you were
using before the firmware was upgraded.
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INPULS v 86
adding components ........... 91
dimensions ........c.ccccceveene. 87
expansion area ................... 85
features ......c.ccocevereennee. 84, 85
jumper configurations ....... 94
jumper locations ................ 94
mounting RCM4510W ..... 11
PINOUL ..o 89
power supply ......ccccevvnnnns 88
prototyping area ................ 90
specifications .................... 88

use of Rabbit 4000 signals 90
R

Rabbit 4000
spectrum spreader time delays
....................................... 79
Rabbit subsystems ................ 27
RCM4510W
mounting on Prototyping
Board .....cccooeoiiiiiien 11
real-time clock
battery backup .........ccc...... 98
Run Mode .....ccocvvvveririennne, 37
switching modes ............... 37
S
sample programs ............. 18, 59
getting to know the
RCM4510W
CONTROLLED.C ........ 18
FLASHLED1.C ............ 18
FLASHLED2.C ............ 18
TAMPERDETECTION.C
..................................... 19
TOGGLESWITCH.C .... 19
PONG.C ..o 14
real-time clock
RTC_TEST.C......coevue. 23
SETRTCKB.C .............. 23

sample programs (continued)
serial communication
FLOWCONTROL.C ..... 20
IOCONFIG_SWIT-

CHECHO.C ................ 22
PARITY.C ..., 20
SERDMA.C ......cccoveee. 20

SIMPLE3WIRE.C ........ 21
SIMPLE5SWIRE.C ........ 21
SWITCHCHAR.C ........ 21
sleepmode ......c.ccoveveneene 66
USERBLOCK_CLEAR.C 47
USERBLOCK_INFO.C .... 47
XBee RF module
AT_INTERACTIVE.C
............... 15, 62, 101, 105
AT_RUNONCE.C ........ 62

MODEMFWLOAD.C
........................... 101, 102
SLEEPMODE.C ........... 63
SLEEPMODE2.C ......... 64
XBEE_GPIO_SERVER.C
............................... 59, 64
ZigBee setup .....ccoovveeenene 59
serial communication ............ 34
function calls ..........c.......... 47
Prototyping Board
RS-232 ..o, 92
software
PACKET.LIB ................ 47
RS232.LIB .....ccccoeeenee. 47
serial ports .....cccocevvevvevennnnn, 34
programming port ............. 36

receive line not pulled up .. 35
Serial Port B (XBee RF
module) ......ccoevviiene 34
Serial Port E
configuration information .
22,34
Serial Port F
configuration information .

22,34
sleepmode .......ccoevevvrivennnne. 65
sample programs ............... 66
ST setting ..cooeveveveevevieen, 65
xb_sleep() ...ccovvrrvennnne. 65, 66
Xb_tick() oo 66

zb_Rabbit_poweroff() ....... 66
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SOFtWAre ..o, 6

external I/0 bus ........... 33, 47
/O drivers ....cccoeevevvennenne. 47
libraries
RCM45xxW.LIB .......... 52
serial communication drivers
....................................... 47
version compatibility .......... 6
ZigBee drivers ................... 49
specifications
bus loading .........ccceevenenene 77
digital 1/0O buffer sourcing and
sinking limits ................ 77
exclusion zone .........c......... 71
header footprint ................. 75
Prototyping Board ............. 88
Rabbit 4000 DC characteris-
HICS o 76
Rabbit 4000 timing diagram
....................................... 78
RCMA4510W ......cceoverenne. 69
dimensions .........c.c........ 70
electrical, mechanical, and
environmental ............. 72
relative pin 1 locations ...... 75
XBee RF module .............. 74
spectrum spreader ................ 79
SEttings ..oovvvvievreeee, 42
subsystems
digital inputs and outputs .. 26
switching modes ................... 37

T
technical support ..........cc....... 16
U
user block
determining size ................ 47
function calls .........ccceene.. 47
readUserBlock() ............ 43
writeUserBlock() ........... 43
reserved area for calibration
constants ........ccceeeeenneen. 47
X
XBee firmware .........cceceevnenen. 6
upgradingto ZB ................ 58
ZB e, 6, 58
Znet 2.5 i 6, 58
Znet25vs. ZB ..., 58
XBee RF module
additional resources .......... 67
firmware download ......... 101
function calls
xb_sleep() ..ooovveverirannnn 99

zh_Rabbit_poweroff() ... 99

Z

ZigBee
software libraries .............. 49

ZigBee protocol
coordinator ...........ceeeeveennee. 57
end device ........cccveeeeennnne, 57
introduction .........c.ccceeene. 57
mesh network ..........ccoev.. 57
FOULET ©vveeeiiiiiiee e, 57
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SCHEMATICS

090-0242 RCM4500W Schematic (preview version)

www.rabbit.com/documentation/schemat/090-0242.pdf

090-0246 RCM4500W Schematic (standard release)

www.rabbit.com/documentation/schemat/090-0246.pdf

090-0230 Prototyping Board Schematic

www.rabbit.com/documentation/schemat/090-0230.pdf

090-0128 Programming Cable Schematic

www.rabbit.com/documentation/schemat/090-0128.pdf

090-0252 USB Programming Cable Schematic

www.rabbit.com/documentation/schemat/090-0252.pdf

You may use the URL information provided above to access the latest schematics directly.
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